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UNIX UNITY
Tired of typing long path
names into the Terminal? In
Tiger, copy the item in the
Finder and paste its path
name into a Terminal window.
From “The Habits of 7 Highly
Effective Mac Addicts,” p30.

PERFORMANCE
ENHANCER
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and able to pick up new
languages quickly? Consider
turning yourself into a Strogg.
From Games, p55.
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Most Power Mac G5s require
matched pairs of RAM, but
iMacs don’t really care how
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We have solutions to improve
any creative process.
(Imagine what we can do for yours.)

Apple® iMac
•
•
•
•
•
•
•
•

1695

$

Intel® CoreTM Duo Processor (2GHz)
Memory: 512MB DDR SDRAM
Built-in Airport® Extreme and Bluetooth® 2.0 technology
250GB hard drive
SuperDriveTM
Mac OS® X TigerTM
20" active-matrix LCD
Includes Apple Front Row, new Remote Control
and Mighty Mouse

CDW 915462

Microtek ScanMaker 1000XL Pro
Large Format Scanner
• Resolution: 3200 x 6400 dpi optical
• 4.0 maximum optical density
• Maximum scan size: 12" x 17"
$2836.99 CDW 850037

HP Designjet 110plus nr Printer
• Prints up to 24" paper width
• Resolution: 1200 x 600 dpi with HP PhotoREt
• Parallel, USB and Ethernet ports
$110 MAIL-IN REBATE AVAILABLE1

$1595.99 CDW 690377

The Mac Solutions You Need When You Need Them.
You’d like to spend as much time as possible focusing on your creative work. CDW
has the solutions that let you do just that. Our account managers can help
you find the products you need to keep the creative process going faster and more
efficiently. So call today for detailed answers to all your technology questions, and
get back to focusing on what you really enjoy: creativity.

1
Call your CDW account manager about available $110 mail-in manufacturer rebate; offer ends 4/30/06. Offer subject to CDW’s
standard terms and conditions of sale, available at CDW.com. © 2006 CDW Corporation
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MacDoppler for Cocoa 1.4.6 trial
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NetShred X 3.16.1 shareware
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PC-Mac-Net FileShare Lite 5.5
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AppZapper shareware
DiscBlaze 6.1 shareware
DiskTracker (Classic)
2.3.2 shareware
DiskTracker (OS X)
2.3.2 shareware
Dobry Backuper 1.3 trial
EasyFind 3.8.1 freeware
FileSalvage 4.2 demo
iGet 2.0.3 trial
MacScan 2 trial
MoosePad X 10.3.1 shareware
Peek-a-Boo 2.4 trial
ShredIt X 5.6.1 shareware
TechRestore Demo Video
WorldTimes 1.1 shareware
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Staff Video: Mac Expo, MacAddict Style
As poet Robert Burns once wrote, “The best-laid schemes o’ mice
an’ men gang aft agley,” meaning that sometimes, no matter how
carefully you plan, tech gremlins can strike—like they did during our
video of the 2006 San Francisco Mac Expo.

UPGRADE

If you don’t receive the Disc with your copy of MacAddict, you might want to consider upgrading. Each monthly Disc contains cool demos, useful
shareware and freeware, and the inimitable MacAddict Staff Video. To get 12 issues of MacAddict that include this value-packed disc with your
subscription (prorated if necessary) for just $1 more per issue, call 888-771-6222—the operator will take care of everything.
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EDITORS’ PAGE
a note from the kernel

Google Gagging
Oddly enough, when you enter the word
toady into Mac OS 10.4’s otherwiseexcellent Dictionary app, its Thesaurus
suggests synonyms such as sycophant,
brown-noser, and lickspittle, but not
Google. This omission strikes me as
strange, considering Google’s decision to
bow to the Chinese government’s demands
that the company censor its search results
as a condition of doing business in that
vast and rapidly growing market.
Try this experiment: Launch www.google.com, click the Images link,
and search for Tiananmen. Tanks, right? Now launch www.google.cn,
click its images link (the second from the left), and try the same search.
Happy tourists and fabulous architecture. What’s wrong with this
picture? A lot.
In slavish pursuit of the almighty buck, Google is lying to 1.3 billion
people. That’s what censorship is: lying. I ask you a question, you
give me an answer you know not to be true, and you’re lying. Although
obvious BS such as whitewashing Tiananmen Square’s history is bad
enough, what’s far worse is the more-subtle lying that the average
Google.cn user can’t detect—and you can be sure there’s a lot of that
crapola.
And don’t forget that Google keeps detailed records of every search
made on its services. Google currently claims that it’s not providing the
Chinese government with the addresses of folks who search for liberty,
freedom, or democracy. It also says it’s not providing the U.S. Justice
Department with American individuals’ information, either. But can we
really trust their assurances?
After all, they’re liars.
In other news: You’ll notice a few changes in this month’s MacAddict.
First, we’ve created a new Games section in which we’ll review the latest
games and gear, preview upcoming releases, and provide tips for the
hottest games available—check it out on page 55.
Second, The Hot List—our monthly guide to the best products in the
World of Mac—no longer ends our Reviews section. Don’t worry, it’s not
gone—we’ve just moved it to www.macaddict.com/hotlist so we can add
direct links to our online reviews.
Finally, take a peek at the month listed in the lower-left corner of
this page—and then don’t be surprised if you run into a bit of foolery
scattered among the pages of this issue.
Enjoy,

STAFF RANTS
Q. What’s your price?

Niko Coucouvanis A BARGAIN AT ANY PRICE
What’s your price?

My price? Either worthless or priceless, depending upon
whom you ask.

Sean Molloy BLACK-MARKET BABY
What’s your price?

Depends what you need. The going rate for a 30-yearold lung is upwards of $225,000. If you want an arm, it’ll
be $179,000 for the right one or $140,000 for the left.
For a limited time only, I’m having a special on kidneys:
$71,000 for a single, $110,000 for the pair. Heck, I’ll even throw in a free
undercoating treatment!

Roman Loyola PAYOLA-PROOF
What’s your price?

As MacAddict’s reviews editor, it’s my duty to remain
impartial, so I can’t be bought off. Vendors can be
persistent, though. Several years ago, for example, I
attended a party at the Playboy mansion to commemorate
the release of a Pamela Anderson CD-ROM. After the party, however,
I decided not to review the CD-ROM. It’s a tough job, but someone’s
gotta do it.

Mark Rosenthal VEGGED OUT
What’s your price?

When I’m in season, you can usually ﬁnd me for about
$3.49 a pound, but during the winter—when I have to be
brought in from Chile in a 20-by-8.5-by-8-foot shipping
container and ripened with ethylene gas—my price can
jump to as much as $5.29 a pound.

Jake Widman EXPENSE NO-ACCOUNT
What’s your price?

What do you mean, what’s my price? I’m a professional
journalist! A free lunch or invitation to your company’s
trade-show cocktail party ought to do it.

Peter Marshutz FREE AND EASY
What’s your price?

Being cheap and easy has always worked well for me,
but unﬁltered access to information and free speech is a
matter of principle and should not be bought and sold. By
censoring searches, Google is selling out to the Chinese
government. If Google were banned in China, big friggin’ deal—it’s a big
planet with billions of other potential customers.

Max EXPENDITURA
What’s your price?

I’ve always been partial to Vincent’s ﬂicks; Fisher kept me
entertained for hours when I was a mere doodle; T. Rowe
manages my meager investments; and although Richard’s
writing for The Wire has been consistently impressive, his performance
as the Library Discussion Leader in episode six of season two was
decidedly underwhelming.

comingsoon:may2006
Here’s what our editors are preparing for the next issue of MacAddict.

We’ll bring you our predictions on both the near and distant future of the Mac, personal electronics, security, and
more—and the news ain’t all rosy. Learn the backup strategies and software you need to secure your data. Our Field
Guide will decode codec, transcode, and other video-editing terms. We’ll show you how your Mac can be a full-scale
broadcast studio, using iChat to record interviews, iMovie to prep video footage, and GarageBand to mix it all up into
a pro-quality video podcast. We’ll work around some of iWeb’s weirdnesses and discover how to tap Pages’ tabular
talents. We’ll also have reviews of Apple’s iWork ’06, BeLight Software’s Swift Publisher, Kodak’s EasyShare One,
MacSoft’s Zoo Tycoon 2, and more.
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the news of the month in bite-size chunks

Universal EFFORT
Developers rush—or at least move with all deliberate speed—
to bring their apps to Intel readiness.

“W

e were all surprised!” said Jacek Stanislawski, software engineer for
Sausalito, California–based Equilibrium, the publisher of such automated
media-processing software as DeBabelizer Pro and MediaRich.

Stanislawski’s surprise came from
Apple’s announcement at the 2006
Mac Expo that an Intel-based iMac was
already heading to stores—nearly six
months ahead of schedule. It’s a surprise
echoed by other developers. “That’s
probably why so few apps are already
shipping,” Stanislawski continued.
“So few” isn’t how Apple would put
it, of course. As of this writing (in early
February), Apple’s Web site lists nearly
700 applications shipping in Universal
format—the format that enables them to
run natively both on existing PowerPCbased Macs and new Intel-based Macs.
(See for yourself at www.apple.com/
universal/applications.) But Stanislawski
has a point: So far, few “major player”
apps have gone Universal.
But that’s going to change—and
according to Quark Director of
Corporate Communications Glen
12
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Turpin, QuarkXPress may be the first
of the big boys out of the gate. “We’re
on track to release a beta to testers
imminently,” said Turpin. “We believe
that QuarkXPress will be the first major
publishing application to run natively on
both PowerPC and Intel-based Macs.”
In a prepared FAQ, Adobe stated that
it “does not plan to re-release current
products as Universal applications”
and is instead “focused on delivering
the next version of these products as
Universal applications.” In other words,
for its existing Creative Suite products,
Adobe intends to stick to its standard
revision cycle of approximately every
18 to 24 months, so expect a new
Photoshop and InDesign between
October 2006 and April 2007. The
company’s new LightRoom, however, is
supposed to come out in Universal form
from the get-go.

Ottawa-based Corel says it, too, will
stick to its usual release schedule for
the Universal version of Corel Painter—
though the company isn’t saying exactly
when that will be. Amanda Lefebvre,
marketing manager for Microsoft’s
Mac Business Unit, said the same of
Microsoft Office: “We typically release
products every two to three years and are
generally on track.” The last release was
in May 2004—we’ll let you do the math.
The Really Good News
So what do you do while you’re waiting
for Office and Photoshop? Play games!
Minneapolis-based Destineer expects
a downloadable patch for Zoo Tycoon 2
to be available by the time you read this.
According to Senior Software Engineer
Phil Sulak, “The Universal Binary for
Zoo Tycoon 2 entered beta testing in
early February. Performance on the new
iMac is excellent—some of best we’ve
seen since bringing the game to Mac
OS X.” Compounding his delight is the
fact that Tycoon required more-complex
Illustration by James F. Kraus
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programming than an app ported
directly from Xcode, Apple’s integrated
development environment (IDE), would
have. “Zoo Tycoon 2 used a number of
third-party software libraries which had
not been ported to Intel,” said Sulak,
“which meant I had to wade through
a lot of PowerPC assembly code. That
wasn’t a fun task at all.”
The programmers for Aspyr’s Doom
3 had an easier time. Glenda Adams,
director of development for the Austin,
TX–based company, said, “Doom 3
was already in Xcode, so it has come
across easily.” A patch should be out
by the time you read this. However,
she continued, “The Sims 2 is at the
other end of the spectrum. It has some
features that Xcode does not allow.
We had to rewrite it so that Xcode will
understand it.” She estimated that
The Sims 2 had one or two months of
development still to go.
Note that when these developers use
the word patch, they mean a relatively
small (probably less than 20MB for Zoo
Tycoon 2, according to Sulak) upgrade
that will turn an existing PowerPC
version of the game into a Universal
version. And—at least in Aspyr’s
case—the upgrade will be free.
OTHER GOOD NEWS
Champaign, Illinois–based Wolfram
Research expects to be shipping a
Universal version of Mathematica by
the time you read this. Theodore Gray,
director of user-interface technology and

cofounder of the company, couldn’t be
more pleased: “As a person who uses
exclusively laptops, the fact that they’re
going back to being just as fast as
desktops is huge.”
Bare Bones’ BBEdit, the workhorse
HTML editor, is already up and running.
“At the risk of making it sound trivial,”
said founder and CEO Rich Siegel, “the
whole process was very straightforward.”
Other productivity-software developers
claimed their apps would ship in
Universal format by the time you read
this (or soon thereafter), including
Webstractor from Softchaos and Font
Card and ShapeShifter from Unsanity.
EXTRA BENEFITS
The Intel switch is not just about speed.
Developers we spoke to said that the
programming transition gives them
the opportunity for a kind of “spring
cleaning” of their wares. “I like these
kind of things,” said Equilibrium’s
Stanislawski. “It was like porting to OS
X; it gave us a great opportunity to fix
bugs. When your apps are on more than
one platform, bugs will show up on one
compiler but not another.” Destineer’s
Sulak echoed this sentiment. “We were
able to make a number of important
adjustments to our underlying software
technologies, and most of the changes
are reusable and permanent. We expect
the overhead on future games to be
much lower, and expect all our future
Mac games to be Universal out of the
box.”—Anita Malnig

NEW STUFF
4TAPELESS HD
Xacti HD1

$799.99
www.sanyo.com
Available: March 2006

Sanyo’s video
camera captures
720p highdefinition video
directly to SD
Fashionably late
memory cards—
to the year of HD.
21 minutes per
gigabyte—as MPEG-4 files. The
camera measures 3.1 by 4.7 by 1.4
inches, weighs 8.3 ounces, and has
a 2.2-inch OLED display.

Put your video
graphics in
motion.

4 RAZZLE-DAZZLE EFFECTS
After Effects 7

$999 (Professional), $699 (Standard)
www.adobe.com
Available: Now

Adobe’s flagship motion-graphics
and visual-effects app features a
revamped interface; visual control
of keyframe editing; customizable
Animation Presets; and support
for HDR color, Adobe Bridge, and
additional file formats.

LOADS OF NEW SOFTWARE?

News of Apple’s move to Intel got some observers wondering: Will this make it
easier to port PC software to the Mac? In particular, will we get games any sooner?
Unfortunately, it looks like the answer is “no.” Corel discontinued its Mac
version of the CorelDraw Graphics Suite in 2004, and Jessica Gould, the
company’s senior communications manager, said that “it does not appear that
Apple’s move to an Intel platform would make the development effort required
to bring CorelDraw Graphics Suite to the Mac any easier.” Destineer’s Phil Sulak
agreed: “When we do a game port, three quarters of the time is spent moving the
game to a new OS and graphics language. Switching CPUs from the PowerPC to
Intel doesn’t really change that equation.”
And in the case of games, it’s not just about the code anyway. Aspyr’s Glenda
Adams said, “Almost every time, the only reason a game doesn’t come to the Mac
is because of licensing, not technology. In a case where the size of the project is
prohibitive to porting, doing an Intel-only version might help—the development
costs might be just lower enough to make it happen. We’d need a large installed
base of Intel Macs to make that work, though.”—AM

Be thankful
it’s not
called the
iJacket.

4 JACKET UP

BlackCoat Work
$179
www.koyono.com
Available: May 2006

Koyono’s lightweight jacket has a fivebutton Eleksen ElekTex Smart Fabric
touchpad sewn into the inside for
controlling your iPod.

April 2006
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the news of the month in bite-size chunks

Sexy Stuff We Can’t Wait to Get Our Mitts On

stor age

IMAGE COURTESY OF SONY

Tape Is So Last YearC
Sony’s DCR-SR100 Handycam ($1,099, www.sonystyle.com)
records video directly to a 30GB hard drive. The camera has a
3.3-megapixel Advanced HAD (Hole Accumulation Diode) CCD that
uses 2,048,000 of those pixels to capture video. It also features
10x optical zoom, a 2.7-inch LCD, and support for Dolby Digital 5.1
surround-sound audio recording.

Zoned OutD

IMAGE COURTESY OF sonos

Sonos’s new ZonePlayer ZP80 ($349, www.sonos.com) connects to
your existing amplified audio device so you can play music from your
Mac remotely (and wirelessly) using Sonosnet, a secure, AES-encrypted,
peer-to-peer wireless mesh network. You use Sonos’s Controller ($399)
to select and play your tunes.
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What’sNew

• EZQuest’s Thunder
Pro A/V Studio
RAID+ Triple
Interface (prices
TBD, www.ezq
.com) is a RAID
0 array with two
FireWire 800 ports,
one FireWire 400
port, and one
USB 2.0 port.
Capacities range
from 1TB to 2TB.
• The MediaBank
Solo ($88 to $268,
www.miglia.com)
from Miglia is
an aluminumencased hard
drive available in
capacities from
160GB to 300GB.
The drive comes
with two FireWire
400 and one USB
2.0 port.
• Maxtor’s Shared
Storage Plus
LaCie Skwarim:
($299.95 to
30GB, all in pink.
$499.95, www
.maxtor.com) is a network storage
device that comes with 100Base-T
Ethernet and a pair of USB ports for
adding more drives or printers.
• The LaCie Skwarim ($149.99 to
$199.99, www.lacie.com) is a 3.3-by3.3-by-0.5-inch USB hard drive with
a case designed by Karim Rashid. It’s
available in two colors: pink (30GB) or
blue (60GB).
• NitroAV’s Vanguard IIIS ($399.95 to
$1,189.95, www.nitroav.com) is an
external RAID 0 or 1 array with eSATA
and USB 2.0 ports. The array holds
two drives, and capacities range from
320GB to 1TB. An enclosure without
drives is available for $239.95.
• OWC’s Mercury On-The-Go ($139.99 to
$215.99, http://eshop.macsales.com)
is a portable hard drive measuring 3.5
by 5.5 by 1 inches. The drive comes with
FireWire 400 and USB 2.0 connectors.
• WiebeTech’s mini USBDock ($74.95,
www.wiebetech.com) attaches bare
SATA drives—either SATA 1 or SATA
2—to your Mac through USB 2.0.
—Michelle Victoria

>>>>>>>>

droolworthy
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Bug of the Month
>>>>>>>>>>>>>>>>>>>>>>>>>>>>

The Banshee desktop speaker provides
surround sound for your ’Pod.

CES Report: Panning
for Nuggets in Vegas

W

W

hen you press Command-Tab to shuffle through open
apps and the Finder, you’re using OS X’s Application
Switching. When you switch to the Finder, you expect any
active Finder windows to appear in the foreground—but
sometimes they don’t. Here are a few ways to restore them.
Restart The longer your Mac has been on, the more likely
this phenomenon is to occur. Restarting your Mac can fix it.
Brain cramp Sometimes an app called StickyBrain
($39.99, www.chronosnet.com) installs a potentially
problem-causing Contextual Menu item. The solution?
Remove the offending file from the /Library/Contextual
Menu Items folder. Deleting it and then restarting can
restore the Finder to normal.
Tap the tilde If you’re in the Finder, try pressing
Command-tilde (~). This combination switches between
active Finder windows.
Expose with Exposé Invoke Exposé (F9) in order to view
the hidden Finder windows immediately.

Intel 101

>>>>>>>>>>>>>>>>>>>>>
a monthly guide to intel buzzwordS

Platform 2015
What it is: Intel’s “long-range
vision” for the next decade
(www.intel.com/technology/
architecture/platform2015).
What the PowerPC equivalent is:
Although all chip manufacturers
including Freescale (PowerPC G4) and
IBM (PowerPC G5) provide product
roadmaps, Intel’s tend to be more detailed and far-reaching.
Why you should care: Intel’s Platform 2015 projects a
computing landscape that will include always-on wireless
devices that anticipate your needs by learning your usage
patterns and daily habits—including, via GPS if you’d like, where
and when you take care of business. Using RMS (recognition,
mining, synthesis) technology, devices will figure out what info
you need, go out on the Web to get data that might help, and
either act upon it independently or assemble it for you—expect
artificial intelligence to slowly replace humans as the dominant
Web surfers. Add this vision to the needs of digital content
delivery, and the future will require major processing power.
To provide that muscle, Intel is banking on CMP (chip-level
multiprocessing) technology that will stuff increasingly large
numbers of processors onto one chip. Intel’s plans include chips
that cram not only dozens, but hundreds of processor cores
onto one chip—and they’ll also have insanely fast on-chip RAM,
snappy hardware that takes over chores currently handled by
Mac OS X, and other goodies all running at miserly power levels.
Well, that’s the plan, anyway.—Rik Myslewski
April 2006
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Illustration by James F. Kraus

hile the bulk of what happened to us at the Las Vegas
Consumer Electronics Show will stay in Vegas, we emerged
only slightly scathed to bring you word of new and noteworthy
items for Mac-minded techies.
After making our way through the satellite radios and
103-inch plasma TVs, we found tons of iPod accessories,
such as eMagin’s Eyebud 800 personal display ($599, www
.emagin.com). It fits over your dominant eye so you can
watch video waaay up close. The Eyebud 800 delivers fullcolor SVGA resolution at 60Hz for a nearly 40-degree field of
view, roughly equivalent to viewing a 105-inch display at 12
feet, says eMagin. The MPEG-4 Recorder 2 ($149.99, www
.neurostechnology.com) from Neuros records video from any
source and transfers it directly to your iPod.
Among the myriad devices designed to increase your ’Pod’s
sonic boom were Shure’s E500 Sound Isolating Earphones
($499, www.shure.com), which manage to fit one tweeter
and two woofers in each earphone, and the Banshee desktop
speaker ($149, www.bansheeaudio.com), which claims to
be the first all-in-one compact five-channel surround-sound
listening station.
Devices such as Belkin’s CableFree USB Hub ($129, www
.belkin.com) and Logitech’s Cordless Desktop S530 Laser for
Mac ($99.99, www.logitech.com) can bring you one step closer
to that utopian wirefree environment. The
CableFree USB Hub
uses ultra-wideband
technology to allow
instant wireless
connectivity of USB
devices. The Cordless
Kodak’s EasyShare V570 includes a
Desktop S530 keyboard
second lens for wide-angle shooting.
(which also comes with
a wireless mouse and USB mini-receiver) is loaded with onetouch Mac shortcuts for iTunes, Mail, iPhoto, and more, all of
which can be customized.
Noteworthy cameras at CES included the five-megapixel
Kodak EasyShare V570 dual-lens camera ($399, www
.kodak.com), which features both a 23mm (35mm equivalent)
wide-angle and 39mm-to-117mm-equivalent zoom lens in
one compact camera body. Olympus previewed the 7.5megapixel Evolt E-330 digital SLR ($999.99 for body only, www
.olympusamerica.com), the first interchangeable-lens digital
SLR to offer a live-view LCD, and the 7.1-megapixel Stylus 720
SW digital compact camera ($399), which is waterproof up to
10 feet and drop-proof up to five.—Michael J. Shapiro

Reveal recalcitrant Finder windows
when Application Switching
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MACPAINT GETS FRESH NEW COAT

SHAREWARE PICK
OF THE MONTH
Butler 4

www.petermaurer.de $18 donationware

E

ven if you have the most blazing and
powerful Mac, you can still work
faster by letting the Mac handle menial
recurring tasks—and Butler’s here to
help. Here’s how to use it to launch a
set of apps with one keystroke.
—Andrew Tokuda

Say hello to the latest Universal application.

A

pple’s Claris division recently announced that MacPaint, the company’s classic
digital-content-creation app, will be released as a Universal app in time for Mac
Expo 2007. According to a Claris spokesmodel, MacPaint users on Intel-based Macs
will see a dramatic speed increase—the Paint Bucket tool will, for example, fill a
selected area 100,000 times faster on Intel-based Macs than on a wicked-fast 40MHz
68030-based Mac IIfx.—Abril Goyo

iPOD CASE OF THE MONTH

When you first run Butler, it greets
you with the About Butler window. Click
the Customize My Configuration button to
create a new task.
2 The topmost group
(called Hidden) is
where you can set up
a key combination
to perform a task.
Let’s say you want to
launch Mail, iCal, and
Address Book in one
swell foop. Click the
plus-sign icon in the
lower-left corner of the window, and then
choose Container from the pop-up list.
3 Drag the
New Container
folder into the
Hidden group.
Now rename
the folder.
4 Drag the three apps
from the Finder into the
container (we named ours
Hot Launch).

The only thing missing is an iHorse or iHandsome iPrince.

T

echnically, iAttire’s iPod costumes aren’t iPod cases, but how can you resist
the way they tap into your inner desire to play dress-up? The little boy or girl in
everyone loves pretending to be a Cowboy ($39.99, www.iattire.net) or Princess
($39.99)—but if you don’t want to relive your childhood through your iPod, iAttire
offers dozens of outfits, from holiday themes to underwear sets, for every ’Pod
under the sun.—Michelle Victoria

SUBMIT YOUR CASE Whether your iPod case is a custom-made one-off or mass produced, you can submit it for
Case-of-the-Month consideration—just send it to iPod Case of the Month, MacAddict, 4000 Shoreline Ct., Ste. 400, South San
Francisco, CA 94080. Please note that we cannot return cases.
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5 To set up the key combo that launches
your three apps, click the Container on the
left side, and then click the Triggers tab
in the Inspector: Container window. In the
Hot Key field, enter
a key combination.
Leave the pop-up
menu below the Hot
Key field at its default,
Launches All Children
Sequentially.

Now your music is good to go
when you are.
With the new iHome™ iH5, your iPod® rocks
even without earbuds. You’ll hear incredibly
rich, natural stereo sound from our Reson8™
speakers. The iH5 even has a digital
AM/FM clock radio.
The iH5 is great in any room. Try one
in the dorm or in your room at home.
The iH5 wakes you gradually or serenades
you to sleep.
And it does it all while charging your iPod,
so it’s good to go when you are.

iHome is home base.

iHome iH5

To order, visit
www.ihomedirect.com

Or call toll free

1.800.925.6224
30 day risk-free trial!

iHome is a trademark of SDI Technologies Inc.
iPod is a registered trademark owned by Apple
Computer Inc. in the U.S. and in other countries.
*Compatible with 3g, 4g, 5g, photo & mini; iPod shuffle
must use line-in jack.
iPod not included.

www.ihomedirect.com

iLife
’06
STRATEGIES
Apple’s iApps let you
share your images,
movies, and sounds
with the world. We show
you how to dodge the
obstacles and oddities
that get in your way.
We’ve been taking a close look
at iLife ’06 since it came out in
January—editing movies, building
Web pages, importing hundreds
of thousands (no, seriously) of
photos. You’ll ﬁnd our considered
verdicts on the following pages,
along with tips and tricks that’ll
take you beyond the obvious
while revealing some of the inner
workings of the new iLife apps. We
like them, and we’ll show you how
to get the most out of them.
By Shelly Brisbin, Niko Coucouvanis,
Logan Kugler, Brad Miser, Rik
Myslewski, and Andrew Tokuda
COMPANY: Apple
CONTACT: 800-795-1000 or 408-996-1010,
www.apple.com
REQUIREMENTS: G4, G5, or Intel Core Duo
processor (733MHz or faster for iDVD); 256MB RAM
(512MB recommended); Mac OS 10.3.9 or later (a few
features, such as photocasting in iPhoto and themes in
iMovie, require Mac OS 10.4.4)

ILLUSTRATIONS BY CAMPBELL LAIRD
April 2006
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iWeb

Meet the new kid on the iLife block: an easy-to-use (if limited) Web-page
creator. Here’s how to get around some of its limitations.—Brad Miser

Frame On

You can type text into
iWeb’s Shapes, but did
you know you can also use
them as custom picture
frames? Here’s how: First,
launch iPhoto and ﬁnd the
image you want to frame.
Export it to your desktop
(unfortunately, you won’t be
able to just drag it from the
iWeb Media Browser). Switch
back to iWeb, click the
Shapes button on the iWeb
toolbar, and choose your
shape; an empty, drab shape
will appear on your page.
Use the shape’s handles
Check it out: Here’s a reshaped, revamped, and totally tricked-out
and the Graphic pane of the
Star shape used as a custom frame.
Inspector palette to place,
size, and conﬁgure the
shape. Then, with the shape
selected, choose Image Fill from the Fill drop-down menu. Drag the image you want to frame onto
the Fill section’s image well (or click the Choose button and navigate to the image). Finally, tweak
the image’s size, border, drop shadow, and other attributes until you are appropriately wowed.
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No Fences

iWeb is loaded with Web
page templates—but no blank
ones. It’s easy to make your
own blank canvas, though.
Start by clicking the plussign button at the bottom of
the Site Organizer. Select a
relatively plain template, such
as the White template with
the Movie page type. On the
new page, select the default
movie and the “Made on a
Mac” statement and press
Delete. Select the text in each
of the text frames and delete
it. You’ll wind up with a blank
page containing the nav bar
and two empty text frames
(you can’t delete a page’s
default text frames). Now
you can resize or move the
empty text boxes, add images
or a custom background—
whatever you want.

iWeb lets you create a
Web site that has stuff
you want the whole world
to see, but you can also
make one with content you
want only speciﬁc people
to view. The easiest way
is to create a second site
and not add any links
to it from your public
site—people will simply
need to know its URL to
get there. To secure it from
those who do happen to
stumble upon it, select
the secret site in iWeb’s
Site Organizer, open the
Sort friend from foe by requiring a
Site Inspector, and click
secret iWeb-site password.
the Password tab. Check
the Make My Published Site Private check box, and enter a user
name and password. When you publish the site to .Mac, the URL
to the secret site will be http://web.mac.com/user name/iWeb/
secret site name, where user name is your .Mac user name and
secret site name is the name of the site in iWeb.

Publish Locally, Think Globally
For best results, publish your site locally before you send it to
your .Mac account. (This is a great timesaver if you’re using a
dial-up connection.) Choose File > Publish To A Folder. Select a
location, and enter
a URL for the site (it
doesn’t really matter
what at this point).
Click Choose. Now
go to that folder and
open the index.html
ﬁle to open the site
in your browser. Use
the links to check out
Publish your site to a folder ﬁrst to make
each page of your
sure everything works and ﬁts.
site, jump back into
iWeb to ﬁx mistakes,
and republish the site. Compare the size of the folder to the free
space on your iDisk (visible from the Site Inspector in iWeb) to
make sure it will ﬁt. Finally, choose File > Publish To .Mac.

Publish Anywhere

You can use iWeb to create a Web site even if you don’t
publish it through .Mac. Just use the technique described in
“Publish Locally, Think Globally” above to create a handy folder
containing all the ﬁles from which your site is made. Now just
upload this folder through the process your hosting service uses
(usually FTP), and your site will be published on that service.
This way, you can use your own domain name and not be stuck
with a .Mac address.

THE
BOTTOM
LINE

iWeb Review

Hide Pages

AMBITIOUS WEBDESIGN TOOL

F

inally there’s a Web-authoring tool for the rest of
us: It’s not overloaded with intimidating toolbars
and palettes, yet it’s powerful enough to crank out
beautiful pages chock-full of your movies, photos, and
whatnot from other iLife apps. And at $15.80—one-ﬁfth
of iLife ’06’s $79—the price is totally right.
n WHAT YOU SEE IS WHAT YOU GET iWeb is
a purely visual design tool. You won’t ever see a bit of
HTML, even if you want to. That’s good for mom and pop,
but uppity Web snobs will be frustrated by iWeb’s pure
WYSIWYG environment. If you do open iWeb-created
pages in a text editor to tweak the code, you’ll discover
mountains of redundant CSS style deﬁnitions and a
tendency to turn the text you write into graphics ﬁles—a
cardinal sin in Web design—when you use nonstandard
fonts. The original text rides along in alt-text tags for the
graphically challenged.
n ALL TOGETHER NOW iWeb supports all of your
iLife endeavors, keeping iTunes, iPhoto, iMovie, and
GarageBand content in its Media Browser. If that’s too
cumbersome, select an Album in iPhoto and press
iPhoto’s iWeb button—it’ll offer a standard photo page or
a blog entry for each photo—or use iMovie’s Share menu.
You can even pipe your GarageBand-created podcast
into iWeb’s Podcast template.
n TEMPLATE TRAUMA iWeb’s templates look
fantastic and include subpages (About Me, Photos, Blog,
and so on). You can modify the templates to your heart’s
content—but you can’t save the modiﬁcations. Other
annoyances: For every blog post you create, iWeb makes
new copies of all of the template’s graphics, which kinda
defeats the server-space-saving beneﬁt of templates.
Also, the app’s page-naming scheme can be downright
witless—there’s no reason to name a blog-post ﬁle
2BC752E4-04B1-458F-B885-6D8A9F64116.HTML. None.
n THE BOTTOM LINE If you can make a better Web
site by hand, knock yourself out. If you want the quickest,
easiest way to share the heaping mounds of content you
produce in iLife’s other apps, you’ll ﬁnd it in iWeb—a slick
little app, but deﬁnitely a 1.0 release.—Niko Coucouvanis

8PROS: Gorgeous output. Simple to use.
8CONS: Produces grossly inefficient code.
Ridiculous file-naming conventions.
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iPhoto 6

Got photos? Lots and lots and lots of them?
No problem! iPhoto’s ready for you, and we’re
ready to impart some of its secret powers.
—Logan Kugler

Unauthorized

So you’re using iPhoto 6
for the ﬁrst time, and you
get a message telling you
iPhoto’s unable to upgrade
your Library because you’re
not authorized. But how can
that be? You’re the only one
who uses your Mac! First,
check your iPhoto Library’s
permissions: Go to /user
name/Pictures/iPhoto
Library, and choose File > Get
Info (or press Command-I).
Click the disclosure triangle
to reveal Ownership &
Permissions, and change
it so you can Read & Write.
Restart iPhoto. If that
doesn’t ﬁx the problem,
there may be a locked photo
in your Library somewhere.
Pore through your image
folders in the Finder and
look for an icon with a gray
padlock in the bottom lefthand corner. (You may have
to increase your icon size
to make it out.) Select the
offending ﬁle, choose File >
Get Info (or press CommandI), and uncheck the Locked
box. Now restart iPhoto.

Faster, Faster!
While iPhoto 6 is deﬁnitely
faster than previous
versions, there may come
a time when you want to
speed it up even further—
especially if you’re using
an older Mac. Try disabling
aesthetic features such as
Outline and Drop shadow
(located in the Appearance
section of Preferences)
and changing to a black
background to get a fair
performance gain.

Photocast to Firefox

Your friends can subscribe to your
photocasts even if they don’t have iPhoto 6.
In Safari 2.x (which includes RSS support),
the URL in the photocast announcement
message will work ﬁne just as it is—in some
other RSS-supporting browsers, however
(such as Firefox), it’ll take you to an error
page. Here’s how Firefox users (including
those on Windows) can subscribe to a
Edit the Photocast-announcement URL to make a
photocast: In Firefox, go to Bookmarks >
Photocast feed work in RSS-capable Firefox.
Manage Bookmarks, and then choose
File > New Live Bookmark. Copy and paste the photocast URL into the Feed Location ﬁeld, and
then change the part that reads photocast.mac.com to web.mac.com. The titles of the Photocast
images will then appear in a submenu (either on your toolbar or in your Bookmarks menu). Select
the images by title to see them in the browser, and Operation Photocast is complete.

A QUARTER MILLION?!
Apple says that iPhoto 6 can handle 250,000 photos; we thought we’d put that claim to the
test. We put our iPhoto Library on a fast SATA II ﬁve-drive RAID 0 array, hooked it up to a
dual 2.7GHz Power Mac G5, and stuffed it with a quarter million JPEGs that averaged about
750KB each—an upload that took four full 24-hour days. We were pleasantly surprised to
ﬁnd that even with 250,000 ﬁles in its belly, iPhoto scrolled along at hyperspeed.
We were far less pleasantly surprised, however, to discover that when we scrolled with
10 or more images in a horizontal row, the thumbnails rarely matched up with the images
they went with. Even worse, in two days of testing, iPhoto thrice requested that we rebuild its
Thumbnail Caches—a four-hour process each time. We’re waiting for iPhoto 6.0.1 before we
try the 250,000-image test again.—Rik Myslewski

22

April 2006

In full-screen editing mode,
iPhoto lets you compare
only up to eight pictures at a
time—but if you need to work
with more, it’s as simple as
performing a right-click (a
30-inch display might come
in handy, too). Just select up
to four images to compare,
Control-click, and then select
Edit In Separate Window
from the Contextual Menu.
A resizable window that
contains all of the basic
editing tools will open for
each photo. Repeat, opening
up to four windows at a time,
for all the images you want
to compare. It’s not quite as
elegant as iPhoto 6’s builtin full-screen editing, but it
certainly gets the job done.

Resize Retouch

You can now modify how the Retouch and Redeye tools work. In
Edit mode, select one of the tools. Press Caps Lock, Control-9,
and then Tab to see your options. On the Retouch tool’s cursor,
you’ll see a dotted circle with “0.50 { }” beneath it. Press the
open-bracket ([) or
closed-bracket (]) key
to reduce or enlarge the
circle, which changes
the size of the area
the tool affects. Press
Shift-[ or Shift-] to lower
or raise the opacity of
the tool. For the Redeye
tool, press Caps Lock,
Control-9, and then Tab
to reveal a target you
can resize with the [
Get rid of lots of freckles at once by
and ] keys.
increasing the size of the Retouch tool.

Backup, Backup, Backup

It’s easier than ever to back up your original images in iPhoto 6.
In previous versions, iPhoto sorted your imported images into
a date-based folder scheme; when you modiﬁed an image, the
app archived the original version into an Originals folder. That
meant your original images could wind up scattered among
several unrelated folders. In iPhoto 6, all imported photos
immediately go to the Originals folder. Backing them up is
as simple as putting that one folder on a DVD.

THE
BOTTOM
LINE
CAPABLE PHOTO
MANAGER AND
EDITOR

iPhoto Review

Compare
More Than
Eight at Once

A

mong the returning iLife ’06 apps, iPhoto 6 is
arguably the most improved—although it still has
some of its old foibles (plus a few new ones).
n UP AND RUNNING When you ﬁrst launch iPhoto 6,
it’ll update your iPhoto Library—and, yes, it still manages
RAW ﬁles by making JPEG working copies and stashing
away the RAW originals. But you no longer need to keep all
your photos in the iPhoto Library; you can now leave them
anywhere you want.
n FULL-SCREEN EDITING The most visible
improvement in iPhoto 6 is full-screen, image-on-black
editing, complete with a Thumbnail bar (top) and Toolbar
(bottom) that can be conﬁgured to pop in and out of view
à la Dock Hiding. You can also compare (and edit) up to
eight images simultaneously in full-screen mode. Be careful,
however: If you Command-Tab to switch apps or choose
iPhoto Help while working in full-screen mode, you’ll bounce
back to Library view and lose all of your editing changes. A
new Effects dialog adds a handful of new one-click effects
such as Sepia and Vignette. The effects can be combined,
and the amount they change the image can be increased by
multiple clicks, but Command-Z removes the entire effect,
not just the last click’s worth. Multiple effects can be added,
but they can only be removed in reverse order.
n SHARING Photocasting—the ability to share photo
albums with other iPhoto 6 users or with Mac or PC
users using RSS clients (such as Safari)—is iPhoto 6’s
other marquee feature. You must be a .Mac subscriber to
photocast, but it’s brain-dead easy and worked ﬂawlessly
in all of our testing. Other sharing features include new
calendar- and card-printing options, an improved selection
of books, and integration with iWeb (see review, p20)—
which works as advertised, if slowly.
n THE BOTTOM LINE Very nice. Most things iPhoto does
feel snappier. It also looks snappier, with an iTunes 6–style
interface. It may have a couple of interface gotchas and some
high-end craziness (see “A Quarter Million?!”, p22), but all in
all, iPhoto 6 is a big step up from version 5.—RM

8PROS: Fast and easy photo management,
editing, and sharing.

8CONS: Some interface idiosyncrasies. Slow
iWeb integration.
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iMovie HD 6

Sure, it’s not Final Cut, but for most of us, iMovie HD 6 has what it
takes to get the job done—with a few caveats.—Shelly Brisbin

Store ’Em
Where You
Want ’Em

To save space on your main
hard drive, install your iMovie
HD themes somewhere else.

Sound Edits

You probably already know
that you can export the audio
track of an iMovie project as
a separate audio ﬁle, but you
might be surprised to learn
that if you do so with a movie
you’ve edited, the exported
audio track won’t reﬂect your
edits. That’s because iMovie
uses nondestructive editing,
hiding but not deleting
material you’ve removed
from the project. To get just
the audio from the edited
footage you’ve decided
to keep, choose Share >
QuickTime, and select Expert
Settings from the drop-down
menu. Click Share, and then
choose Export > Sound To
AIFF. Click Save to export the
post-editing audio from your
movie in a format you can
use in iTunes, GarageBand,
or any other audio app.

Some iMovie HD 6 users
have already experienced
problems with plug-ins,
including Apple’s new Quartz
Composer video-effects
plug-in and third-party
offerings that have not yet
been upgraded. Internal
changes to iMovie have
affected the way plug-ins
work—some plug-ins for
previous versions of iMovie
work normally, and some
don’t. There is a workaround,
but it only works for some
plug-ins (such as the
GeeThree Slick collection):
Try closing the Preview
bar before manipulating
the plug-ins’ conﬁguration
settings. If the workaround
doesn’t work for you, keep
checking Software Update
for upgrades, and frequent
your favorite plug-in vendor’s
Web site for iMovie HD 6
compatibility updates.

THE
BOTTOM LINE
SLIGHTLY BUGGY VIDEO EDITOR

W

e’ve always liked iMovie (mostly) and version
6 is the same old love/hate story. It has slick
new tricks, but also some of the same choking
on long projects we’ve experienced in previous iMovie
releases.
n EASY, NOT CHEESY iMovie’s new themes provide
graceful intro, chapter, and credits screens via drop-in-yourown-footage templates with editable titles.
n MAKE TIME A new Editing mode makes it easier to
access Titles, Transitions, and the new Video FX. Effects
apply noticeably faster, and previewing is instantaneous.
n SHARING iMovie HD 6 can share content with iWeb
and GarageBand, but we’re even more thrilled that it can
share content with itself: Dragging clips from one open
project into another is revolutionary. The themes match
the new iDVD themes, which makes pushing a project
onto iDVD seamless.
n THE BOTTOM LINE iMovie remains the best combo of
power, simplicity, and low price. Until the 6.0.1 release, just
remember to save your work often.—NC

8PROS: Real-time main-window effect

previews. Multiple open projects.

8CONS: Still chokes and crashes on long,
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iMovie HD Review

The iLife ’06 installer lets
you custom-install support
ﬁles for iMovie, iDVD, and
GarageBand, meaning you
can keep them on a volume
other than your startup
disk—useful if you’re short
on space. To do so, click the
Customize button on iLife
’06’s Installation screen, and
then click the triangle next
to iDVD to reveal the iDVD
Themes line. Click the arrows
next to Install to choose a
new location.
If you’ve already installed
the whole shebang and
now want to move your
themes, launch a text editor
such as TextEdit, and open
com.apple.imovie.plist in
/Library/Preferences at the
root of your startup drive.
Change the path name
from the default (/Library/
Application Support/iMovie/
Themes) to the name of the
folder where you’re going to
move your themes. If you’re
using an external drive, be
sure to include the drive’s
name in the new path. Save
and close the plist ﬁle, and
then move the Themes folder
into its cozy new home.

Plug-In Woes

complex projects.

It’s a shame
that iDVD
doesn’t get as
much updating
attention as its
iLife siblings—as
these tips show,
it packs quite a
pro punch.
—SB

iDVD 6
Button Up, Button Down

When iDVD imports an iMovie project with chapter markers,
iDVD decides in what order to place the buttons associated with
each chapter. You can, however, change the button order or
even move a button from one menu page to another. To do so,
click the Buttons tab, then the Free Positioning radio button;
now you can drag a scene button (and its label) wherever you
want. To move a button from one menu page to another, choose
Free Positioning, cut the button from its current location, and
paste it onto the page at the position you want it to appear.

Dual Burn?

iDVD 6 is the ﬁrst version with built-in support for third-party
DVD burners, including dual-layer (DL) models—but not all duallayer models. To ﬁnd out whether iDVD supports your dual-layer
drive, open a project, choose Project > Project Info, and note
whether the DVD Type menu allows you to choose DL mode or
not. If it does, you’re golden.

iPhoto Slideshow Confusion

Because you can have slideshows in your iDVD projects, it’s
easy to assume that slideshows you create and conﬁgure in
iPhoto would be available from iDVD’s Media > Photos pane.
They’re not. Only albums (and the Library) from iPhoto 6 appear
in iDVD. To add the contents of an iPhoto slideshow to an iDVD
project, you need to do some prep work in iPhoto.
First, create and conﬁgure the slideshow the way you want
it in iPhoto 6. Now either send the slideshow directly to iDVD,
which adds the slideshow to your project’s front page, or
export the slideshow as a movie and drag it into iDVD. To give
the slideshow an express ticket to iDVD, choose Share > Send
To iDVD. To save the slideshow as a movie instead, choose
File > Export (previously Share > Export). Name the slideshow
and choose a size from the Movie Size pop-up menu (Small or
Medium works best). By default, the exported slideshow will
be stored in the Movies folder, which is just where it needs to
be for iDVD to ﬁnd it. Click Export. In iDVD, click the Media tab,
then Movies, and drag your slideshow onto your project.

iDVD Review

THE
BOTTOM LINE
SLICKER NO-FUSS DVD MAKER

A

With Free Positioning selected, you can arrange your scene
buttons (that were chapter markers in iMovie) as you like them.

Start from Scratch

You might be surprised when you import your latest iMovie
project into iDVD 6 and discover that is has taken on the
attributes of the last iDVD 5 project you worked on. You can
switch themes, of course, but a better way to lessen confusion
after you upgrade is to create a new dummy iDVD project before
you import your ﬁrst movie. Open iDVD 6; the last project you
worked on appears. Choose File > New, and name and save the
dummy project. Choose a theme from the list of iDVD 6 themes,
and then quit iDVD. When you’re ready to start a real iDVD
project or import one from iMovie, it’ll look like your dummy.

pple could rename iDVD 6 to iDVD HD: It supports the
widescreen (16:9 aspect ratio) format of today’s high-deﬁnition
displays—and HD cameras, if you’ve got the budget for one.
n JACK BE NIMBLE iDVD’s new HD support furthers the app’s
versatility. The 10 new themes look good (we especially like Reﬂection
and Pass Through) and work well with iMovie’s new themes (see p26).
The themes support both widescreen HD and boob-tube-friendly 4:3
projects—you can even force a widescreen aspect ratio on iDVD’s old
4:3 themes.
n JACK BE QUICK DVD burning has always been frustrating for
the chronically impatient—even 8X burners take forever to burn a full
disc—but iDVD 6 soothes the other pain. Map view, which lets you
plan out your entire project in a ﬂowchart, is ﬁnally usable—you can
even restructure your project by dragging icons around the map and
letting iDVD recreate the important linkages for you.
n THE BOTTOM LINE Version 6 cures our main iDVD complaint
by adding burn support for disc images and external DVD burners.
Considering the complexities of DVD authoring, it’s an incredible
tool.—NC

8PROS: Snazzy new themes. Easier and more
customizable than ever.

8CONS: Can’t add Drop Zones to menus.
April 2006
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GarageBand 3

Apple’s good ol’ audio-creation app has more than a few tricks up its sleeve—especially
if you’re into podcasting. Here are a few tricks you can use today.—Andrew Tokuda

Avoid Monitor Mush

You may want to listen to yourself on headphones while you
record your voice, which you can do by turning on Monitor in the
Track Info pane. The problem is, you might experience latency
(the slight time delay between what’s recording and what’s
being played back), and you’ll hear yourself in your headphones
a few milliseconds after you speak—very disorienting. A better
solution? Plug your headphones into an audio interface that has
its own hardware monitor, such as the M-Audio Fast Track USB
($129.95, www.m-audio.com), and turn off GarageBand’s own
monitor.

Lock to Set Yourself Free

When you use audio effects such as the Speech Enhancer for
your podcast voice tracks, you use precious processor power.
The more effects you pile on, the more work your Mac has to
do. Eventually, it may have to work so hard that you can no
longer play your tracks. To ease the load, click the Lock button
on the individual tracks after you ﬁnish them. This renders
them to disk so that the effects will become part of the audio
ﬁle itself, meaning the CPU won’t have to process them in real
time. If you need to make changes to a track, just unlock, edit,
and relock.

One Voice, One Channel

The voice tracks in GarageBand default to stereo. On most audio
setups, this means your voice will end up on either the left or
right channel—which may be ﬁne for an interview, but not so
great when it’s just you. Save yourself the editing trouble and
record your voice in mono in the ﬁrst place (you only have one
microphone pointed at your mouth, right?). Click the Voice track
you wish to record, and choose Track > Show Track Info. In the
Input pop-up menu, choose Channel 1 (Mono) to put your voice
dead center.

Unless you
talk out of
two sides of
your mouth,
record stuff
in mono.
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If you’ve ever listened to Howard Stern or his imitators, you’ve
probably heard wacky sounds play after jokes. In GarageBand,
these are called Stingers—and if you’re recording a podcast,
you can trigger Stingers using a MIDI or USB keyboard or
GarageBand’s onscreen Musical Typing keyboard. Select the
Radio Sounds track, and in the Track Info pane, select Sound
Effects > Radio Sounds. Choose an effect category from the popup menu, such as Applause And Laughter or Comedy Noises
(the rim shot is a time-honored classic). Enable recording on
both a voice track and the Radio Sounds track, and you can
press keys on whatever keyboard you’re using to trigger the
Stingers and punctuate your brilliance while you speak.

THREE STEPS TO
SOUNDING LIKE A RADIO DJ
HERE ARE SOME WAYS TO MAKE YOUR
PODCAST SOUND LIKE A REAL RADIO SHOW:
AMBIENCE = AMATEUR The ﬁrst step to sounding more
“radio” is to use a cardioid microphone, which is designed to pick up
audio at the business end while blocking sound from the sides and
back. Such mics start at about $50, and even the cheapest will sound
waaaay better than the mic in your Mac. Get close to it (about two to
four inches from the tip) when you’re recording. Aside from reducing
ambient noise, a cardioid mic will increase the amount of bass in your
voice, which’ll help give you that FM-radio DJ sound (and which is
why DJs usually don’t sound quite the same in real life).

EVERYONE HATES POP While getting close to a
microphone can add radio sexiness to your voice, it also introduces
a problem with plosives: When you pronounce consonants such
as B and P, blasts of air hit the mic, resulting in pops that can be
very annoying. To prevent problematic podcast plosives, angle
the microphone slightly so that the air coming from your mouth
doesn’t blast directly into it. The pros use a pop ﬁlter: a disc with a
piece of air-stopping material (commonly nylon) placed between a
microphone and your mouth. Pop ﬁlters start at about $20.

COMPRESS IT Compression reduces the dynamics of audio,
bringing the soft and loud parts to a consistent level. This increases
the perceived “loudness” and makes you sound more “in-your-face.”
To ﬁnd GarageBand’s Compressor slider, go to the Track Info pane,
choose Real Instrument > Podcasting, select a track, and click the
Details triangle. Feeling daring? Choose AUDynamicsProcessor
from the third pop-up menu, and go nuts.—AT

Compress your
audio, and—if you
dare—get into
the AUDynamics
Processor for
more-serious
sound tweaking.

THE
BOTTOM
LINE
SMART AND
EASY PODCAST
GENERATOR

GarageBand Review

Live Stingers

G

arageBand 3 doesn’t add many features for
musicians, but it does play to a wider audience:
podcasters and (to a lesser degree) video editors.
Creating a new project now gives you two more options:
New Podcast Episode and New Movie Score.
n SCORING The movie-score option introduces a
new Video track, onto which you can drop a QuickTime
movie. It’s a great new feature for iMovie users who have
been frustrated by iMovie’s limited number of tracks. We
foresee a bazillion tacky music videos in 2006.
n PODCASTING The podcast-oriented features make
it easy not only to record a ’cast but also to enhance it
with chapters and hyperlinks. Choosing New Podcast
Episode in the opening screen sets up a project with ﬁve
tracks: a Podcast track, two voice tracks, and Jingles
and Radio Sounds tracks. The Jingles track is a Real
Instrument track into which you can insert radio-ish song
fragments and sound effects from a new Loop Browser.
The Radio Sounds track is a Software Instrument track
that lets you add Stingers such as laughter, applause,
funny voices, and so on. All this can make your podcast
sound more like a professional radio talk show—whether
that’s a good thing or a bad thing depends on your taste.
The special Podcast track is where the enhanced
magic happens. To create a chapter, just drag an image
from the new Media Browser to the timeline. You can give
each chapter its own title and URL in the Track Editor.
By default, you can export the ﬁle to iTunes and iWeb
via the Share menu. If you don’t want to use iWeb for
creating your RSS page (which is how folks subscribe to
your podcast), you can choose Preferences > Export >
Save To Disk and use third-party software to do the XML
coding yourself.
n THE BOTTOM LINE Overall, Apple thought a lot
about what podcasters might want, and GarageBand fulﬁlls
the needs of both amateurs and professionals.—AT

8PROS: Podcasting features are useful and well
thought-out.

8CONS: No significant update for musicians.
Shelly Brisbin uses iMovie to document every facial expression of her twin
nieces. Logan Kugler is counting the pennies under his bed, then he’s off
to Mars. When he isn’t using iWeb to strut his own stuff, Brad Miser writes books
such as Using Mac OS X Tiger. Andrew Tokuda often has to remind himself that the
spacebar won’t pause the real world. Niko Coucouvanis and Rik Myslewski work here.

April 2006

27

Left

�����������������������
����������������������
�����������������������������������������
�������������������������������������������
���������������������������������������������

����������

������������������������
���������������������

�������������������
�����������������
�������

�������

����

�� �

�

�� ����

�

�����������������

����

�� ���

������������������

����������������������
���������
�������
����

��

������������������

�������

����

�� ���

�

����

������������������

��������������������������
���������������������
��������
����

�� ���

�

���������������������������
����������������������������

�������
�����������

����������������������
���������������������

��������������

����

�����

����

�������

��� �

�

�������

����

��

�

�����������������

������������� ��

�

�� �

�

�

�������������
����������������

��

�����������������

�

Left

�

����

�

�����������������

�������������������������������
�������������������������������
�������������������������������

�

����

��

�������

�� �

�

��

�

�����������������

�������������������

�������
���

����

�

�

������������������

����

�������

�����������������

�����������������
���������

�

�����������������

��� �

�

��

�

�����������������

����

�

�����������������

�������

��� �

�

����

���

������������������

��������������������
������������������
������������������
�������

�� ���

�

�

�������

����

�

���������

�����������������

�������

�� ���

�

��

�
�
�
�
�
�
�
�
�
�
�

�������

������������������ ���������������������

�������

����

��� �

�

�

�����������������

������������������
������������������������
���������������

��������������������
��������������
�����������
�������

�������

�

��

�����������������

���������
���������

����

������������������������������������������
��������������������������������������������
�������������������������������������

�

�

�

�

�
�

��
����

�� ���

�

�����������������

�

�

�

Right

�����
���� � ��������
�
�����

����������
��������������

���������������
������������

����������������� �����������
���������������
�����������

���������������������������
�����������������������������������
��������������������������
��������������������������

�������������������������������
����������������������������������
���������������������������
����������������������

�����������������������
����������������������������������
����������������������

����������������������������
�����������������������������������
����������������������������������

�����������������������

���������������������

�������������� ���

�������������������� ����

�����������������

����������������

�����������

�����������

����������������������

��������������������

�

�

�����������

�����������

����������������������������

����������������������������

�

�

�

����

�

������

����

�

����

�

����������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������
��������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������
��������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������
���������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������
���������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������
��������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������
������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������
��������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������
��������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������

������������
��������������

���

�

�

�

�

��

���

�

���

�������

���

�

���������������
����������
�������

��

�

�������������������������������
��������������������������������
�������������������������������

���������������������
������������������������
�������

��

�

����

�����������������

��

�

�����������
����������������

����

���

�

��

�

�����������������

�������

���

�

���

��� �

����

��

��

�����������������

�

�������

��

�

�������������������������������
��������������������������������
�������������������������������

����������������������� ���������������
�����������
����������������
��������������������
�������

�

��������������
����������������

�������
����

���

�

��

�����������������

�

����

�����
����

�

�����������������

���������������������
������������
�������
����

��� ��

�

�����������������

�

Right

7

The Habits of

HighlyEﬀective
Mac Addicts

Improve your Mac life by doing as these experts do.
No matter how you use your Mac, you eventually develop your own habits—some good, some bad. Follow
our advice, and you’ll wind up with the good habits of the pros. (We’ll leave the bad habits up to you.)
By Garrick Chow, Brian P. Lawler,
John Rizzo, Chris Stone, Andrew
Tokuda, and Johnathon Williams
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Efficiency Expert

She’s all about maximum work with minimum
effort. She brushes her teeth in the shower and
balances her checkbook at the gym. When she’s
using her Mac, every keystroke counts.

NEVER DO THE
SAME THING TWICE
The key to efficiency is letting your
Mac do most of your work for you. If
you find yourself repeating a simple
task, take a few moments to automate
it. For Mac OS 10.4 users, Automator
(/Applications/Automator) offers readymade commands that you can drag and
drop to create simple programs called
workflows. If you have an older system

MacScripter (www.scriptbuilders.net),
or check out “An AppleScript Arsenal”
(Mar/06, p34).

FORGET FOLDERS
With Mac OS 10.4, the old method of
finding files by hunting through nested
folders became blessedly obsolete.
These days, power users create Smart
Folders (Command-Option-N) to sort
and update important groups of files

Ordinary folders are so 2005. The smart kids
are using self-updating Smart Folders.

automatically—you can, for example,
place a Smart Folder on your desktop
that lists every Word document you’ve
modified in the last week. For files you
need less frequently, use Spotlight
(Command-spacebar) to instantly pluck
them from their hiding places on your
hard drive. And the next time you go
rooting through your Documents folder,
remember to kick yourself.
—Johnathon Williams

If You Only Do One Thing…

Concentrate on the Keyboard
The mouse may have revolutionized personal computing, but true efficiency comes
from the keyboard. Hot-key combinations can access menu items in a fraction of the
time it takes to point and click. Fortunately, the Mac comes with dozens of built-in
key shortcuts, such as Command-Tab
to switch between open apps (you knew
that, right?) and Command-Shift-L in
Safari to do a Google search on selected
text. When you’ve exhausted the defaults,
add more with Unsanity’s Menu Master
($10, www.unsanity.com), which adds
custom shortcut keys to menu items in
Hot keys are the, um, key to ultimate
any Cocoa or Carbon app, saving you a
power—and Menu Master can grant it to you. lot of extra motion and wrist strain.

Want to have Apple’s Mail automagically
send you your to-do list every day?
Automator replaces the arduous task of
scripting with the simplicity of drag and drop.

or a more complicated task, the Script
Editor (/Applications/AppleScript/Script
Editor) can help you write sophisticated
tools in AppleScript, an English-like
scripting language straight from
Cupertino. But before you delve into the
intricacies of scripting, look for freebies
that solve your problem, and get familiar
with the scripts that come preloaded on
your Mac by installing the script menu.
(In Mac OS 10.4, go to /Applications/
AppleScript/AppleScript Utility; in
previous versions, try /Applications/
AppleScript/Install Script Menu.) Find
more free workflows and scripts at
Illustrations by Darren Thompson

Multimedia Maven

He uses his Mac to edit video or audio; he’s an
artist as much as he is a technical wiz. He works
the mouse like a paintbrush and uses both sides
of his brain—and the hottest tech he can find.

MONITOR ELSEWHERE
Don’t preview TV-bound video on your
Mac’s display—use a calibrated external
broadcast monitor or a good television
instead. Why? First, video color space
is different from Mac color space, so
a video monitor lets you make moreaccurate color corrections. Second,

most video is viewed on an interlaced
display—a TV, for example—on which
lines 1, 3, 5, and so on are drawn first,
followed by lines 2, 4, and 6, too fast for
the human eye to notice. A Mac display
is progressive, meaning it draws all the
lines in order. An interlaced display lets
you catch flickering and other anomalies
April 2006
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that won’t show up on a progressive
display.

DRIVE FAST
Audio and video applications read
and write a lot of data, so you want a
hard drive that spins fast and has a
speedy interface—get one that rotates
at a minimum of 7,200 rpm and has
a FireWire 400 (IEEE 1394) or faster
interface. If you’ve got a money tree
growing in your backyard, go for an
Xserve RAID with Fibre Channel.

LISTEN UP
Never use the Mac’s speakers to monitor
the audio in your productions: To put it
bluntly, they’re small and sucky. At the
very least, get a good pair of closedear headphones (sorry, earbuds are
small and sucky, too) or a good set of
speakers. Better still, use the audio
outputs from a FireWire or USB audio
interface, which can handle higherresolution audio for more-accurate
sound. And if audio work is what puts
food on your table, spring for surround
sound, baby!

EMBRACE “BIG”

Forget “consumer adoption rates”—
you’re supposed to be ahead of the
game. Stop stalling.

BECOME AN AMATEUR
You may have all the production chops
in the world, but that doesn’t mean you
shouldn’t touch consumer-level apps
such as iMovie HD and iDVD. If you’re
a video pro and think that you’re above
using Apple’s premade templates, take
a second look and see if you can do
better. Oh, you can do better? Well,
can you do it as fast? Didn’t think so.
—Andrew Tokuda
Don’t think iMovie HD is good enough
for the pros? Then the amateurs might
just run you out of business.

If You Only Do One Thing…

Keep Up with the Joneses
With podcasts and vlogs (video blogs) reaching everyone’s Macs and iPods, this is an
exciting time for audio and video. While the sheer amount of content being generated
every second might make it tough to be a pioneer in this new media, it’s your job to at
least ride the waves and pay attention to what
other people are creating. The iTunes Music
Store is a great first step—go to the Podcasts
area and check out the new world of media.

For the video pro, the future of highdeﬁnition video is now. There will soon
come a day when tube TV is a relic and
your plain old DV camcorder looks as
dated as a hand-cranked movie camera.

You won’t make your mark if you don’t keep up
with what your colleagues and competitors are
doing—start with some free podcasts.

Image Consultant

She spends her day editing photos and designing
Web pages. She can’t work unless she can see
what she’s working on. For her, it’s all about color:
What she sees really has to be what she gets.

SET YOUR CAMERA SPACE
If your digital camera allows you to set
its color space (all pro cameras and
many consumer models do), set it to
Adobe RGB (1998). The result? A bigger
color gamut—brighter reds, bolder
blues, and visibly greener greens.

SET COLOR CORRECTLY
Most people who use Photoshop don’t
get this right, but it makes a world of
32
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difference in how your images look
and print: Go to Edit > Color Settings
(in Photoshop CS, go to Photoshop >
Color Settings). If you do Web work,
choose Web Graphics Defaults. If
you design something destined for a
printer, choose U.S. Prepress Defaults,
then change the CMYK setting to U.S.
Sheetfed Coated V2. The result? Your
camera, your Mac, and your printer will
match one another more closely.

PROFILES? YES!
When you open a photo in Photoshop,
use the embedded profile if it has one.
If it doesn’t, first try assigning sRGB
(for most consumer cameras). If the
color looks wrong, close the photo and
try again using a different profile—the
second choice is Apple RGB (which
handles many stock photos). Finally,
try ColorMatch RGB, which was popular
during the life of Radius PressView CRT
monitors.

See this dialog box? Say OK.

SHOOT RAW
Again, if your camera offers it, shoot
your images in the RAW format. If you’re
used to shooting in JPEG, shooting in
RAW will result in larger files that’ll
fill up your memory card quicker—but
the results will be worth it. You can
turn even the worst RAW image into
something good in Adobe Photoshop or
Apple Aperture by adjusting the color
temperature, exposure, brightness,
contrast, and more. On top of that, those
pesky image artifacts you see in nearly
every JPEG image will be gone.
—Brian P. Lawler

If You Only Do One Thing…

Calibrate, Calibrate, Calibrate
You can’t rely on what you see until you calibrate your monitor. If you can afford a
profiling instrument such as the ColorVision Spyder2 Express ($99, www.colorvision
.com), that’s best. If you can’t afford the hardware, at least do a visual calibration:
Go to System Preferences > Displays > Color, and
click the Calibrate button. The Display Calibrator
Assistant will take you through a series of palettes
that ask you to judge the appearance of your
display. The last step creates a ColorSync profile
to use with all applications.

Answer some questions, and the Display Calibrator
Assistant will build a ColorSync profile for your display.

Security Maniac

He mutters “backup, backup, backup” in his
sleep. He backs up as often as some of us
press the Save button. He’s obsessive. He’s
compulsive—but he’s secure.

BACK UP EVERY DAY

DON’T BE FIRST

One day, you will find yourself with a
sick hard drive; and you’ll thank the
heavens that you’ve been backing
up regularly just like mom told you
to. There are plenty of backup apps
available, including Carbon Copy Cloner
(donationware, www.bombich.com) and
Déjà Vu ($24.95, http://propagandaprod
.com), and some FireWire drives come
bundled with backup software. Use it.

You don’t need to be an early adopter:
Let the other guys be the first to upgrade
to Mac OS 10.5 or the major new version
of your favorite app. If you can’t wait,
first visit MacAddict.com, MacInTouch
.com, and MacFixIt.com to see what
problems early adopters may be having.

GET DISC WARRIOR
Mac OS X’s Disk Utility is the first course
of treatment in resuscitating a hard
drive, but when it fails, call in heavy
hitters such as DiskWarrior ($79.95,
www.alsoft.com). It often fixes problems
that Disk Utility can’t.

KEEP IT CLEAN
For Zeus’s sake, don’t randomly install
toys that you find on the Internet. They
may work just fine now, but the next
time Software Update upgrades your OS
to 10.4.x, you might find yourself with
a work-halting incompatibility problem.
Also, keep Dashboard widgets to a
minimum.

BUGS ENTITLED
TO APPEAR
Never install beta software. If you’re
wondering why not, just read the title of
this tip. If the software’s good, a moresolid version will appear later.
—John Rizzo

If You Only Do One Thing…

Make a Big Bootable Backup
Use your backup software to make an exact copy of your main hard drive—invisible
files, settings, passwords, and all—on an external FireWire hard disk. That way, when
(not if) your internal hard drive goes south, you can start up from the FireWire drive
and immediately get back to work. (Restoring tens of gigabytes of data from a dozen
DVDs is going to take you a weekend.) Having a bootable drive also saves you from
having to start up your Mac from your OS-installation DVDs or CDs.

Crossover Artist

Maybe he’s a Mac holdout in an office full of
Windows users. Maybe he uses Windows at
work and a Mac at home. In either case, he
ignores cross-platform issues at his own peril.
If he wants to keep his Mac, it’s up to him to fit in.

FRIENDLY EMAILS
Make sure to send your Windows
compadres attachments that they can
open. In Mail, go to Edit > Attachments
and choose Always Send Windows
Friendly Attachments, which strips the
attached file’s Resource fork (which
Windows can’t read). In Microsoft
Entourage, go to Preferences > Mail &
News Preferences > Compose. In the
April 2006
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Attachments section, choose Encode
For Any Computer (AppleDouble) or, if
that doesn’t work, Encode For Windows
(MIME/Base 64).

sometimes show up on a Mac as a
file called winmail.dat. The actual
attachment is wrapped up inside the
winmail.dat file, which the Mac can’t
decode—unless you have TNEF’s
Enough (free, www.joshjacob.com), a
utility from developer Josh Jacob that
can crack open the file and extract your
attachment.

your files, you have to get the filename extensions right. In the Finder,
select Finder > Preferences. Click
Advanced, and check Show All File
Extensions.—John Rizzo

SYNCHRONIZE
ENTOURAGE SERVER

If you want documents to look the same
when viewed on both Macs and PCs,
the Microsoft Office fonts are the safest
way to go—Times New Roman, Arial, and
the rest. To find out the whole list, take
a look in /Applications/Microsoft Office
2004/Office/Fonts.

If you’re required to use Entourage
because your company has an
Exchange Server—or if you just use
Entourage because you like it—you’ve
probably been missing out on syncing
to your iSync-compatible devices and
apps. Go get e2Sync ($39, www
.e2sync.com) and start syncing your
Entourage Contacts, Tasks, and
Calendars with iSync, iCal, Address
Book, and iSync-compatible devices
such as Palm OS PDAs and certain
cell phones.

DECODER RING

EXTENSIONS ON!

Email attachments sent from
the Windows version of Outlook

If you want to be sure your Windowsusing brethren will be able to open

Want Windows users to be able to open your
attachments? Of course you do.

LIMIT YOUR FONTS

Road Warrior

Whether propped up on pillows in a hotel room,
pulled over on the side of the road in a rental car,
stranded in an airport, or flying high at 37,000 feet,
this guy knows how to work while on the move.

AIRPORT EXPRESS
WILL SET YOU FREE
Although many hotels tout in-room
broadband connections, most of the
time the Ethernet connection keeps you
tethered to a desk, just like back at the
office. After a long day on the road or in
a boardroom, a desk’s the last place you
want to be while reading your personal
email or surfing the Web. The solution:
Whip out your AirPort Express, connect
it to the room’s Ethernet port, and
browse from the comfort of your bed,
kitchenette, balcony—or bathroom.

LIGHTEN YOUR LOAD
Go through your bag before your trip and
toss the junk—ticket stubs and rental34
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car agreements from previous trips,
cables you won’t need, matchbooks
from random clubs where you had, uh,
“business lunches,” old magazines, the

Give Windows users the help they need
by keeping file extensions turned on.

If You Only Do One Thing…

Be Conventional

Stick with the Windows file-naming
conventions: Avoid most punctuation
and slashes (underscores and
hyphens are OK). Don’t use more
than one period in a file name. Don’t
start a file name with a space. And
always use an extension—.doc, .pdf,
and so on.

works. It’ll make it that much easier to
find the stuff you need.

CARRY A CARD READER
Popping the memory card out of your
camera and into a card reader sure
beats digging a cable out from your
bag and connecting it to your camera.
Plus, you save your camera’s battery
for taking pictures instead of wasting
it sending pictures to your Mac. As an
alternative, consider the iPod Camera
Connector ($29, www.apple.com),

If You Only Do One Thing…

Stay in Charge

Without juice, your ’Book is more useless than a spiral notebook, so charge your
battery whenever possible during your trip. If you have a layover, keep an eye out
for the coveted wall outlets around your departure gate, and stay plugged in as long
as possible before boarding. If your seat onboard doesn’t have a power outlet, your
batteries (you do carry an extra, right?) will have to last the entire flight, so conserve
power by lowering the brightness of your screen and turning off your AirPort card.
The chances of finding a Wi-Fi connection in the stratosphere (much less an
unencrypted one) are slim to none, and your AirPort card will needlessly drain your
’Book’s battery.

which lets you dump your photos to
your iPod.

FILES IN A
FLASH (DRIVE)
Don’t forget to bring an iPod shuffle or
flash drive—either one is a great tool to

transfer files quickly from your Mac to a
coworker’s computer, especially while
on the road where Internet connections
might not be available. By comparison,
burning a few text files to a CD is time
consuming and inefficient.
—Garrick Chow

Terminal Geek

For her, mousing around in the Mac’s GUI feels
unnatural. She is at home with the command line,
and her goal is to send signals from her brain to
Mac OS X’s Unix kernel as quickly as possible.

OLD SKOOL

AS YOU LIKE IT

Find your Terminal windows instantly
in a sea of white (and bring back
fond memories of computing in the
eighties) by setting the Terminal
window to display green text on a black
background. Go to Terminal > Window

Configure your Terminal windows and
store their layouts as TERM files that,
when opened, recreate the windows
exactly as you left them. First, size and
place a window (or a group of windows)
however you please and configure the
color, font, and any other
settings in Terminal > Window
Settings. When you’re done,
select File > Save, and choose
to save the Main Window or All
Windows. You can even specify
a command to run when the
window or windows open. Give
the layout a name, and store
the file in your /user name/
Library/Applications Support/
Terminal folder (create it if it’s
not there) to make it available
from the Terminal’s File >
You won’t lose your Terminal window when it’s the only
Library command.
green-on-black window on your screen.
Settings, select Color, and choose
Green On Black from the pop-up menu.
Click Use Settings As Defaults, and
you’ll swear you’re peering into the
glass of a terminal screen from days
gone by.

QUICK PATHFINDER
Mac OS X has always allowed you
to drag an item from the Finder into
a Terminal window to automatically
enter its path name at the command
prompt (with troublesome characters
properly squelched). Tiger does that one
better: Select and copy the item in the
Finder, and paste its path name into the
Terminal window.

REMOVABLE FLASH If you have the right
kind of camera, you can adopt the previous
two habits with the HP USB Digital Drive
($24.99, www.hp.com), a pocket-size USB
drive that accepts SD cards. You can use it to
copy files back and forth, or you can plug in
the card from your camera to transfer images.

Tools for *nix Jockeys

Want more than the Terminal’s builtin features? Try these enhancements:
■ Window managers on other Unix
systems allow you to switch among
multiple desktops, and Codetek’s
VirtualDesktop Lite ($20, http://
codetek.com) brings that feature
to Mac OS X. Keep different apps’
windows on different virtual desktops,
and click a dialog or use a key combo
to swap them in and out. The pricier
VirtualDesktop Pro ($40) adds “focus
follows mouse” capabilities, allowing
you to activate any app’s window
by simply hovering your cursor over
it—no clicking required.
■ Apple’s Terminal is nice enough,
but many in the geek crowd prefer
iTerm (http://iterm.sourceforge
.net), the open-source terminal
emulator that adds tabbed windows,
bookmarks, and more.
■ If you store shared ssh keys on
your Mac to allow passwordless
logins to remote machines, use
SSHKeychain (donationware,
www.sshkeychain.org) to have the
keys disabled whenever your Mac
Keychain is locked, a crucial security
feature (especially for laptops). Make
sure to check the included read-me
file for important usage hints.

E-Z OPEN
Even if the Terminal icon isn’t in the Dock,
you can still launch it in a blink from the
Finder by pressing Command-Shift-U (to
open /Applications/Utilities), T (to select
the Terminal), and Command-Option-O
(to launch the selection and close its
parent Finder window). Master that trick,
and you’ll open the Terminal faster than
you can through the Dock.—Chris Stone

iTerm improves on the basic Terminal
window by adding tabbed windows.

Garrick Chow is that guy sitting on the airport ﬂoor charging his PowerBook, phone, and ’Pod
while eating tiny bags of pretzels. Brian P. Lawler teaches graphic arts classes at Cal Poly
University and wrote Adobe Print Publishing Guide: Second Edition. John Rizzo is the author of Mac
Mini Mods and Hacks for Dummies and runs MacWindows.com. Chris Stone is a senior systems
administrator at O’Reilly Media and is still not sure that he likes being called a geek. Andrew Tokuda
edits video when the sun comes up and composes music when the sun goes down. After years of
slacking, Johnathon Williams can almost be called productive, thanks to Automator and AppleScript.
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Field Guide to APPLE.COM

Secret Treasures of Apple.com
By Niko Coucouvanis

A

pple’s Web site is a glorious sprawl of technical data, product information, software downloads, and other components of the
Mac Good Life. The only problem is that it can be tough to ﬁnd what you need. Some goodies are in plain view, but others are
buried in the virtual catacombs. Follow us as we take you on a tour—just be sure to watch your step and bring your ﬂashlight.

Support Secrets
APPLE DOWNLOADS

www.apple.com/downloads
You can easily ﬁll up a hard disk right here. Whether you’re looking for Automator actions,
Dashboard widgets, the latest version of iTunes, or a full-blown Mac OS X system update, start
here. This area is especially handy on those rare occasions when an update doesn’t agree with
your Mac and you have to go back to a prior version—but it’s also ﬁne if you’re just looking for
a few non-Apple game demos.

APPLE MANUALS

www.apple.com/support/manuals
Do as we say, not as we do: Read the freakin’ manual. You can get tons of ’em here.

APPLESPEC SPECIFICATIONS

www.info.apple.com/support/applespec.html
Can’t remember what video chips came in your eMac or how much RAM you can cram into a Quicksilver Power Mac G4? Find out here.

DO-IT-YOURSELF PARTS & SERVICE

www.apple.com/support/diy
If you need to add RAM to your PowerBook or a second hard drive to your
Mirrored Drive Door Power Mac G4—or ﬁeldstrip a ﬁrst-generation iMac
G5—this page has step-by-step PDFs to guide you.

MAC 101

www.apple.com/support/mac101
Cleverly hidden on
Apple’s Support page,
Mac 101 provides the
handholding some
ﬁrst-timers need to
get acquainted with the Mac and Mac OS X—such as a ﬁve-lesson introduction
to the Mac interface and an explanation of how to hook up your digital devices.

SWITCH 101

www.apple.com/support/switch101
It’s like Mac 101 for Windows refugees. Here’s where to ﬁnd out how to move
documents from Windows’ My Documents folder to Mac OS X’s Documents folder.

General Appleness

Investor Relations
www.apple.com/investor
Keep an eye on Apple stock, earnings
reports, SEC ﬁlings, ﬁnancial history, and
other ﬁscal fun.
Job Opportunities
www.apple.com/jobs
Aim high, as they say.
Mailing Lists
http://lists.apple.com
Apple hosts scores of subscription email
lists, including a few for end users and
user-group leaders, and a lot for high-end
developers (howzabout some Fortran for
Mac OS X?).
User Groups
www.apple.com/usergroups
There are hundreds of Apple user groups
out there—this page will help you ﬁnd ones
in your locale.
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For the DinoMacs
APPLE LEGACY PRODUCTS SUPPORT

www.info.apple.com/usen/legacy
Need software for your Newton? A new battery for your Performa? The correct cable for your StyleWriter II printer?
Check out the FAQs and forums on the Apple Legacy Products Support page to ﬁnd out exactly what to get.

OLDER SOFTWARE DOWNLOADS

www.info.apple.com/support/oldersoftwarelist.html
Apple’s own Wayback Machine, this page lists downloads for Apple software released before Mac OS 8.1 (circa 1998), all the way
back to the Apple II. Cyberdog, anyone?

For Developing Geeks
APPLE DEVELOPER CONNECTION (AKA THE HOLY GRAIL)

https://connect.apple.com
Dig into Apple’s Developer pages and you’ll reach the creamy
center: the Apple Developer Connection (ADC). Sign up for a free
Online Membership, and you’ll be able to download such bountiful
booty as Apple’s Xcode Tools (823MB), the latest Developer
Documentation (641MB of PDFs), and SDKs for everything from
Core Audio to Xsan. If you don’t know that SDK stands for “software
development kit,” you should probably leave this section of Apple’s
site alone.

QUICKTIME TOOLS AND UTILITIES

http://developer.apple.com/quicktime/quicktimeintro/tools/index.html
When you’re ready to switch from media consumer to producer, check here for tools to help you create and deliver QuickTime content.
Need to get your animated 3D models into QuickTime? Grab 3D Movie Maker. Want to provide alternate versions of your movie for
different connection speeds? Here’s MakeRefMovie X. And if
you ever get overwhelmed, ﬁnd tutorials at www.apple.com/
quicktime/tutorials.

Other Must-Bookmark
Mac Sites
EveryMac.com
www.everymac.com
Find detailed specs on every Mac model ever
made, active forums, and other fun stuff.

Info-Mac HyperArchive
http://hyperarchive.lcs.mit.edu/HyperArchive.html
Need software? MIT’s HyperArchive mirror
has boatloads.
Versiontracker
www.versiontracker.com
Got software? Look here to track down the
latest version of everything.
MacInTouch
www.macintouch.com
Got a problem? All the smart guys ’n’ gals
hang out at this site’s Reader Reports.
MacAddict
www.macaddict.com
You thought we were gonna forget this one?

REFERENCE LIBRARY
(AKA INFO OVERLOAD)

http://developer.apple.com/referencelibrary
Go to school here. The library is broken down into main
sections (Documentation, Release Notes, Sample Code,
Technical Notes, and Technical Q&As). You can browse by
resource type or dig right into a topic (such as Accessibility,
Cocoa, Hardware, Mac OS X, and so on) to view all of its
reference materials. You might want to bring a lunch.

UNIX GUI TOOLKITS

http://developer.apple.com/unix/toolkits.html
You’ve heard of the X11 windowing system that lets you run Unix apps without all
of the usual command-line geekery, right? Here’s where to get it, along with other
Unix development tools. Find some apps that run on X11, such as GIMP (GNU Image
Manipulation Program), at
www.apple.com/downloads/
macosx/unix_open_source.
Niko Coucouvanis still misses Dave Reynolds’s Tech Info Tidbits from the MacAddict of
yore (circa 1998).
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RATIN¬S
You’ll be
blown away.

You’ll be
impressed.

You’ll be
satisfied.

You’ll be
disappointed.

You’ll be
pissed off.

REVIEWS

39

better living through smarter shopping

Spring is here, and that means it’s time to get some color back into your life, starting with Canon’s PowerShot
SD30 (pictured). While the new iMacs are your standard Apple white, we’re sure you’ll be rosy with glee if you
get your hands on one. Next month, we’ll have reviews of Softpress’s Freeway 4 Pro Web-design software,
M-Audio’s Podcast Factory audio-production package, Kodak’s EasyShare One camera, and more.
40
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17-inch iMac Intel Core Duo iMac
20-inch iMac Intel Core Duo iMac
Chat Transcript Manager 1.0.1 iChat transcript software
Curve Headphones for MP3 headphones
DictJuggler Web-research utility
FileMaker Pro 8 Advanced database software
HyperTranscribe transcription software
iChant iPod speaker
Intuos3 6x11 wide-format tablet
iPod Radio Remote FM tuner and remote
iZ iPod speaker
MacCapture video-capture software
One-Button Mouse pointing device
PowerShot SD30 camera
Q2ID QuarkXPress-to-InDesign converter
Smart Label Printer 430 label printer
StudioPro 3 monitors
StuffIt Deluxe 10 file-compression utility

Games
This month, we inaugurate our new Games section
with some advice on how to conquer Quake 4, a testride of the RollerCoaster Tycoon 3, the lowdown on the
upcoming Heroes of Might and Magic V, and more.

PHOTOGRAPH BY SAMANTHA BERG
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Heroes of Might and Magic V coming soon
Legion Arena coming soon
Quake 4 tips and tricks
RollerCoaster Tycoon 3 simulation-game review
The SpongeBob SquarePants Movie kids’ adventure-game review
X-Arcade Trackball Mouse trackball review

We’d spend our
own hard-earned
money on this
product.
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Same ol’ iMacs on the outside.
A whole new world inside.

17- and 20-inch
iMac Intel Core Duos
SNAPPY ALL-IN-ONE MACS

T

ransition isn’t anything new to your
Mac life. In fact, it’s an integral part
of it. Perhaps you made the PowerPC
transition back in 1994. Chances are
you remember when you upgraded to
Mac OS X. Maybe you’re still recovering
from Apple’s decision to drop ﬂoppies.
SCSI to FireWire, ADB to USB, LocalTalk
to Ethernet, one-button to multibutton
mouse—now it’s time for another
transition: the switch from PowerPC to
Intel processors.
Apple’s ﬁrst Intel-based Macs, the
17- and 20-inch iMac Intel Core Duos,
debuted at last January’s Mac Expo.
We’ve spent the last couple of weeks
putting them through a ton of tests
and relying on them for everyday use.
Our verdict: The new Intel-based iMacs
are more than adequate for general
consumer use, with no drastic changes
in the Mac experience.
Changes inside. At the heart of
the new iMacs are Intel Core Duo
processors. The 20-inch iMac has a
2GHz processor; the 17-inch iMac has a
1.83GHz one. A Core Duo contains two
separate processors on a single chip;
each processor shares 2MB of L2 cache
(for details info, see “iLife on Intel,”
Mar/06, p25). The standard-equipped
iMacs come with 512MB of DDR2
SDRAM clocked at 667MHz, but unlike
40
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the previous iMac, the Intel iMacs use
the SODIMM memory usually found in
notebooks rather than the DIMMs found
in Power Macs. The two memory slots are
located in the lower center of the iMacs,
and you can replace or add memory by
unscrewing a small panel and inserting
the SODIMMs. Upgrading’s easy—and
recommended, since Rosetta (Apple’s
PowerPC-to-Intel software-translation
technology) is quite the RAM hog.
The 20-inch iMac we tested came with
a 256MB ATI Radeon X1600 graphics
system—a $75 upgrade from the 128MB
X1600 that comes with the base 17- and
20-inch models, and a ﬁne replacement
for the X600 graphics system found in
the previous iMac generation. Apple’s
also dropped the mini-VGA port found on
the iMac G5 and replaced it with a miniDVI port, which requires an adapter ($19)
for connecting a composite, DVI, S-Video,
or VGA display. (The new iMacs support
up to a 23-inch Apple Cinema Display.)
The Intel iMacs also support extendeddesktop mode and mirroring—bravo!
Similarities. Like the previous iMacs,
the 20-inch Intel iMac comes standard
with a 250GB 7,200-rpm SATA hard
drive, while the 17-inch iMac comes
with a 160GB model. You also get an
8X double-layer SuperDrive, AirPort
Extreme, Bluetooth 2.0, Gigabit

Ethernet, and an iSight camera built
in above the LCD. Speaking of the
iSight, you can now use 640-by480-resolution video with iChat AV,
a welcome increase from the previous
resolution of 320 by 240.
The outside appearance of the Intel
iMacs is identical to their G5-based
predecessor—don’t worry, there’s no
gaudy Intel Inside sticker on these
babies. The Intel iMacs come with Front
Row (which ran smoothly and without
problems in our tests).
Testing. To test the speed of the new
iMacs, we ran a battery of tests, using
both Intel-native apps and apps that
require Rosetta. For reference, we also
ran the same tests on a 17-inch 1.9GHz
iMac G5 (
Jan/06, p24) and
a dual 2GHz Power Mac G5 (
Dec/03, p50), both of which had the
processor performance set to Highest
(System Preferences > Energy Saver >
Options > Processor Performance).
In most of our tests involving apps
that run natively on both PowerPC
and Intel machines—Universal apps,
in Apple’s parlance—the new iMacs

Bye, mini-VGA. Hello, mini-DVI (far right).

showed moderate speed gains over
the G5 Macs. When using iDVD 6 to
create a OneStep DVD from a movie, for
example, the 2GHz 20-inch Intel iMac
was 15 percent faster than the 1.9GHz
iMac G5; the 1.83GHz 17-inch Intel iMac
was 9 percent faster. When applying
Sepia Tone Video FX in iMovie HD 6,
the 20-inch Intel iMac was 19 percent
faster than the 1.9GHz iMac G5, while
the 17-inch Intel iMac was 13 percent
faster. The 20-inch Intel iMac was an
impressive 45 percent faster than the
1.9GHz iMac G5 (the 17-inch Intel iMac
was 26 percent faster) when importing
196 JPEG photos into iPhoto 6. When we
used GarageBand 3’s Send To iTunes
feature, both Intel iMacs were 6 percent
faster than the 1.9GHz iMac G5. While
these aren’t earthshaking gains, the
new iMacs do feel snappier.
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FileMaker Pro 8 Advanced
SOLID UPGRADE TO A GREAT DATABASE

FileMaker Pro 8 Advanced’s PDF exporter includes security features for restricting access.

T

he newest version of the perennial
FileMaker Pro database has few
headline features, but lots of little
improvements here and there combine
to make your database-driven life easier.
Previous versions of FileMaker Pro
have lacked sensible data-export
options, so FileMaker’s new ability
to export directly to Microsoft Excel
is a godsend. Excel’s analysis and
presentation functions are better—and
easier to use—than FileMaker’s. In
the past, exporting FileMaker data
into a CSV (comma-separated values)
ﬁle for use in Excel was often the ﬁrst
port of call for anyone wanting to dig
deep into data. But CSV exports are
often inaccurate; with FileMaker’s new
direct-to-Excel export, you don’t have to
venture into CSV’s dismal and accidentprone world.
Version 8 includes a powerful PDF
generator. While you can generate PDFs
using OS X’s Print To PDF function, that
method lacks many useful functions and
is useless when developing a crossplatform database.
ON THE
With FileMaker’s PDF
DISC generator, you can add
FileMaker Pro 8
metadata (such as
COMPANY: FileMaker
CONTACT: 408-987-7000 or
800-725-2747, www.filemaker.com
PRICE: $499 (full), $299 (upgrade)
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Title and Author) and specify passwords
for opening, editing, and printing PDFs.
FileMaker Pro 8 also adds an emailmerge function that saves trips to
the Scripts menu and prevents crossplatform pondering. You can now create
one or multiple emails using database
ﬁelds, and even add an attachment
if you like. Finally, an importer lets
you bring data into your database,

You can use all of FileMaker’s powerful
calculation tools to create email merges.

creating a new table of ﬁelds on the
ﬂy—a considerable timesaver over the
previous manual process for bringing in
a complicated existing database.
FileMaker Pro 8 Advanced (formerly
called FileMaker Pro Developer) has a

REQUIREMENTS: G3, Mac OS
10.3.9 or later, 256MB RAM

few extra bells and whistles to make
developers’ lives easier. A data viewer
lets you monitor variables so you can see
how your development changes affect
them. You can disable script steps, which
helps in pinning down the source of a
bug, particularly in combination with the
improved Script Debugger, which lets
you step through scripts line by line to
ﬁnd the cause of your problems. Finally,
the oft-wished-for table importer is here,
making it easy to duplicate existing table
schemas and combine several FileMaker
ﬁles into a single database. The table
importer isn’t perfect (particularly if
there are many relationships among the
ﬁles), but it’s a good start.
Finer details. FileMaker Pro 8’s biggest
strengths are in the ﬁne details: calendar
pop-ups for entering dates more easily,
tool tips to explain features of layouts,
script variables so you don’t have to
deﬁne global ﬁelds every time you
store an intermediate value, an instant
Find function to ﬁnd records whose
values match the currently selected
ﬁeld, layout-alignment tools for making
ﬁelds the same length, tabbed layouts,
auto-complete, and a Word-like spelling
checker that underlines mistakes. Taken
separately, no single improvement is
killer. Together, however, they make
FileMaker Pro 8 a worthwhile upgrade.
There are a few minor issues, many of
which are leftovers from version 7. Small
fonts still render poorly, particularly
when right-aligned. Using FileMaker
layouts as the basis for electronic forms
is still a trial-and-error affair, since what
you see is not always what you get when
printed. Also, changes have apparently
been made to the layout engine, as
some our previously pixel-accurate
layouts now appear disjointed. Check
your old layouts closely, just to make
sure nothing’s slipped.
The bottom line. Despite the layout
problems, FileMaker Pro 8 is an excellent,
worthy upgrade.—Rob Buckley

GOOD NEWS: Integrated PDF production. Excel export.
Dozens of usability improvements. Better development tools.
BAD NEWS: Problematic table-import tool. Some layout
bugs still not fixed.
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We’re partial to Vivacious
Violet, but you can choose
from three more colors.

PowerShot SD30
CUTE POINT-AND-SHOOT CAMERA

T

he words cute and compact aptly
describe Canon’s PowerShot SD30
digital camera. It’s nice for those times
when fun takes priority over studious
photography—and since it comes in
four different colors, you might even
consider it a fashion accessory.
The SD30 houses a ﬁve-megapixel
CCD imager and 2.4x optical-zoom lens
within its tidy 3.78-by-1.78-by-0.94-inch
frame—it’s small enough to carry around
in your coat pocket or purse. The camera
has a 1.8-inch LCD; ISO settings of 50,
100, 200, and 400; and a shutter-speed
range from 1/1,600 of a second to 15
seconds. The camera comes in four
colors—Glamour Gold, Rockstar Red,
Tuxedo Black, and Vivacious Violet—and
you even get a leather carrying case that
matches your chosen color.
Like many recent point-and-shoot
digital cameras, the SD30 doesn’t have
an optical viewﬁnder (leaving out the
viewﬁnder helps maintain the small
size), so you have to rely on the camera’s
LCD to frame images. While the absence
of a viewﬁnder doesn’t affect your
digital image, using the LCD in bright
sunlight can be problematic. To offset
COMPANY: Canon
CONTACT: 800-652-2666 or
516-328-5000, www.canon.com
PRICE: $399.99

the missing viewﬁnder, the SD30 has an
interesting feature that we recommend
you use—you can activate a grid pattern
on the LCD that helps you align your
subject vertically and horizonally,
making it easier to get exactly the shot
you want.
The camera comes bundled with
a 16MB MultiMediaCard (MMC), but
that won’t get you very far—ditch the
included card and pick up one with more
capacity (the SD30 can also use SD
cards). Since the SD30 doesn’t use any
ﬁle format other than JPEG (there are
several compression levels to choose
from), you’ll be able to capture a lot of
images on even a 256MB card.
The SD30 has several shooting
modes, starting with the obligatory
Auto and Manual. Beyond these you
also get Landscape, Night Snapshot,
and Special Scene, the “special scenes”
being presets for shooting in snow,
on the beach, with kids and pets, or
underwater (though the SD30 isn’t
waterproof; you need the optional $169
Canon AW-DC40 waterproof housing).
The SD30 has a built-in ﬂash; when
using it, we recommend leaving the

REQUIREMENTS:
Mac OS 10.2.4 or later

ISO on Auto. We tried
snapping photos using
the ISO 50 and ISO 100
settings and found the
images to be just a little
underexposed; leaving
the ISO on Auto lets the
camera determine the best
ISO setting for each individual situation.
The drawback to using Auto ISO: Several
of our test images were grainy, indicating
that the camera had chosen a faster
ISO than we would have in the situation.
Other images had poorly focused objects
in the background or the foreground,
telling us that the camera had selected
a wide aperture.
You can download the SD30’s images
to your Mac by using the included
camera dock, which connects to your
Mac via USB 2.0. Docking the camera
also recharges its battery—which, by
the way, took us about three hours, not
the 90 minutes stated in the manual.
The dock also has an A/V port for
connecting to a TV (a cable is included)
to see your camera’s images on a big
screen. We also attached the SD30 to
a few Canon PictBridge-compatible
printers and had prints in our hand
within a few minutes.
The bottom line. The SD30 started
a lot of conversations when we hit
the party circuit—its small size and
attractive colors generate a lot of
interest. However, beyond the cosmetics
lies the brutal truth: For its price, the
SD30 doesn’t quite reach the same high
level of image quality and performance
we’ve seen in other Canon point-andshoot cameras.—Rick Oldano

GOOD NEWS: Compact size. Fashionable camerabody colors.
BAD NEWS: Image quality isn’t bad—but it isn’t great,
either. No optical viewfinder.
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Q2ID
VALUABLE QUARKXPRESS-TO-INDESIGN CONVERTER

C

equivalents—in these
an Adobe InDesign
cases, circular blends
open QuarkXPress
for diamond ones,
documents? It’s an
and hyphenation and
important question
justiﬁcation settings for
for page-layout pros.
paragraphs and paragraph
Historically, the answer has
styles. Because the two
been yes—and no. Now
apps use different text
there’s a more robust and
engines, text ﬂow is not
efﬁcient way to make sure
identical after conversion.
the answer’s always yes:
Given the number of
Markzware’s Q2ID, which
features in both apps,
lets InDesign CS and CS2
we weren’t surprised
open documents created
that Q2ID hiccupped a
with the Mac and Windows
few times. In our early
versions of QuarkXPress
testing, some QuarkXPress
and QuarkXPress Passport
documents wouldn’t open
3.3, 4.1, 5, 6, and 6.5 (the
in InDesign, while others
current version). It even
had noticeable differences
lets you save them as
after conversion; for
InDesign ﬁles.
example, some objects
InDesign natively
that were transparent in
opens only documents
QuarkXPress had a white
created with QuarkXPress
ﬁll in InDesign. On the
3 or 4; if you want to
plus side, Markzware tech
open QuarkXPress 5 or 6
support was extremely
documents in InDesign,
helpful (they immediately
you have to save them in
ﬁxed our ﬁll problem),
QuarkXPress as version
and the company seems
4 ﬁles—an unreliable
eager to work out whatever
and labor-intensive job,
glitches remain—it’s
especially if you need
already released several
to convert numerous
updates and will likely
documents. Q2ID is a norelease more based
frills, easy-to-use utility
Most of the time, a Q2ID-converted InDesign document (bottom) looks
on user feedback. It’s
that signiﬁcantly enhances identical to the QuarkXPress original (top). Most of the time.
also worth noting that
InDesign. For current
InDesign’s built-in conversion tool is
QuarkXPress ﬁle isn’t affected. If you
QuarkXPress 5 and 6 users who are
far from perfect.
hold down Control-Command-Option
considering switching to InDesign, Q2ID
The bottom line. QuarkXPress users
when opening a QuarkXPress 3.3 or
can make the transition go much more
who are avoiding InDesign because they
4.1 document, Q2ID is disabled and
smoothly.
don’t want to rebuild their QuarkXPress 5
InDesign’s built-in conversion kicks in.
Plugged in. It’s easy to use Q2ID
and 6 documents now have a compelling
In our tests, Q2ID did a remarkably
after you install the software into
incentive to switch—just don’t expect
accurate job of placing graphic and text
InDesign’s Plug-Ins folder. Simply
perfect results every time. The more
frames, converting colors, translating
choose File > Open, and then select
complex the QuarkXPress document,
character and paragraph styles, and
a QuarkXPress document. The newly
the more likely you are to ﬁnd differences
rebuilding master pages. QuarkXPress
converted document automatically
after you convert. Still, Q2ID is a potent
features that aren’t available in
receives InDesign’s .indd extension.
plug-in, and a must-have for anybody
InDesign, such as diamond-shaped
The next time you choose Save or Save
who needs to convert QuarkXPress 5
blends and H&J speciﬁcations, are
As, you name the InDesign ﬁle and
and 6 documents.—John Cruise
converted to the closest InDesign
choose a destination folder—the original
COMPANY: Markzware
CONTACT: 800-300-3532,
www.markzware.com
PRICE: $199
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REQUIREMENTS: G3, Mac OS
10.2 or later, 128MB RAM, 250MB
disk space, Adobe InDesign CS or
InDesign CS2

GOOD NEWS: Does an excellent job converting most
QuarkXPress documents.
BAD NEWS: Converted documents don’t always exactly match
the originals. Doesn’t always work glitch-free.
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Smart Label Printer 430
CONVENIENT LABEL PRINTER

P

rinting mailing labels with a printer
not speciﬁcally made for that task
can be a test. The problem isn’t so much
that you need to be smarter than the
printer (though that certainly helps)—
it’s more likely that you just need a
smarter printer. The Smart Label Printer
430 is the cream of Seiko Instruments’
Smart Label Printer crop, and it’s smart
indeed, printing razor-sharp text and
bar codes via direct thermal transfer
with no ink required—the downside is
that it only prints on special thermally
sensitive labels.
The labels aren’t particularly
expensive or hard to ﬁnd; they’re selfadhesive, waterproof, and come in sizes
from 1.125 by 2 inches (return-address
size) to 2.125 by 4 inches (shipping-label
size). Just make sure you have Seiko’s
COMPANY: Seiko Instruments
CONTACT: 800-688-0817,
www.siibusinessproducts.com
PRICE: $189.99

latest software (version 1.1
as of this writing); before
we upgraded, the older
software provided
precious few clues as
to what size media we
were setting up our label
template to accommodate.
With the proper driver, we simply
had to select our label size from
the pull-down menu. If you can’t ﬁnd
SLP-speciﬁc labels or happen to have a
stash of off-brand labels on hand, the
driver includes presets for using Avery
and DYMO labels.
Despite its simplicity, the SLP remains
smart. We had painless results whether
printing basic, no-frills labels straight
out of Apple’s Address Book or printing
custom jobs via the included Smart

REQUIREMENTS:
Mac OS 10.2 or later

This label printer’s
dumbest feature
is its name.

Label Printer
software—
which works
quite smartly
with Address
Book for easy contact
importing and batch printing. It
also offers easy visual-layout tools to
free you from the rigidity of templates
(though the SLP’s are perfectly ﬁne).
The bottom line. The SLP 430 is quiet,
quick, and capable; our only real beef
is that using its image-import feature
on graphics more complex than two-bit
clipart produces a mottled mess—a
common malady of thermal printing.
—Niko Coucouvanis

GOOD NEWS: Quiet. Simple to use. Smart software can
generate postal and UPC-style bar codes.
BAD NEWS: Could be faster.

StuffIt Deluxe 10
IMPROVED FILE-COMPRESSION UTILITY

F

ormerly the Mac ﬁle-compression
tool of choice, StuffIt lost mindshare
when Mac OS 10.3 included built-in Zip
compression and expansion. Allume
Systems has had to work hard to make
StuffIt a worthwhile app to buy; the
result is StuffIt Deluxe 10, which builds
on version 9’s already impressive list
of features to provide an even more
tempting package.
The top addition is a Spotlight plug-in
for exposing the contents of StuffIt,
Zip, and TAR ﬁles to Spotlight searches.
Allume’s plug-in is more consistently
effective than Ziplight (free, www
.bartastechnologies.com), which lets
Spotlight see Zip content, but StuffIt’s
support for formats like TAR is what
makes it invaluable.
COMPANY: Allume Systems
CONTACT: 888-245-1723,
www.allume.com
PRICE: $79.99
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StuffIt Deluxe also comes with
useful Automator actions for
including different compression
and expansion formats in your
workﬂows. A particularly nice touch
is the ability to view thumbnails of
images stored in SITX ﬁles, so you
don’t need to decompress them just The price may make you think twice about StuffIt
to see if they’re they contain the
Deluxe 10.
ﬁles you’re looking for.
StuffIt is still glacial compared to OS X’s
There are other new features
multithreaded Zip compression.
that Deluxe shares with the cheaper
The bottom line. Alas, all of these
StuffIt Standard ($49.99). These include
goodies are obscured by StuffIt Deluxe’s
a compression system that Allume
$79.95 price ($29.99 to upgrade). If it
claims can reduce JPEG ﬁle sizes by 30
were less expensive, StuffIt Deluxe would
percent, improved .Mac support, and
be a more compelling tool; instead, this
a better encryption system. We would
utility is a luxury that many Mac users
have liked more focus on speed instead
can live without.—Rob Buckley
of some of these latter options, since

REQUIREMENTS: Mac OS 10.3 or
later (Mac OS 10.4 for Automator and
Spotlight support)

GOOD NEWS: Good Spotlight plug-in. Handy image preview.
Compresses JPEG files by 30 percent.
BAD NEWS: Pricey. Most features already appear in StuffIt
Standard.
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StudioPro 3
CLEAN-SOUNDING MONITORS

Speakers? Nope.
These are monitors.

M

-Audio’s StudioPro 3 may look like
a nice set of powered speakers,
but technically, it’s a pair of monitors.
What’s the difference between speakers
and monitors? Monitors attempt to
reproduce the originally recorded sound
as closely and realistically as possible,
a necessity in studios. The sound that
emanates from these self-powered
monitors is squeaky clean: singing
highs, emphatic mids, and punchy
bass. Turning on the bass boost adds
a signiﬁcant amount of boom, though
probably not enough to please bass
freaks—but total thump isn’t what these
monitors are about.
The StudioPro 3 monitors are solidly
built with wood wrapped in plastic
veneer, and they’re constructed
COMPANY: M-Audio
CONTACT: 626-633-9050,
www.m-audio.com
PRICE: $99.95

to minimize vibration and prevent
interference from your Mac and other
devices. Each monitor has a one-inch
tweeter for highs and a 3.25-inch woofer
to handle mids and lows.
Two rear-mounted RCA jacks act as
your main input (an RCA-to-1/8-inchstereo-jack cable is included), and two
1/8-inch jacks sit on the front of one
speaker: one auxiliary-device input and
one headphone output. Each monitor

REQUIREMENTS:
Mac or other audio device
with audio-out port

measures 8 by 5.5 by
5.9 inches, and both
together weigh about
9 pounds. As a nice
added touch, M-Audio
includes a set of stands to
help position the speakers at
the correct angle and some foam pads
to further dampen vibration.
The bottom line. Whether you’re
setting up your ﬁrst home recording
studio or even looking for an alternative
to run-of-the-mill powered speakers,
the StudioPro 3 desktop audio monitors
are a relatively inexpensive way to get
sweet, accurate sound reproduction.
—Gil Loyola

GOOD NEWS: Solid construction. Great sound. Nice price.
BAD NEWS: Bass may not be enough for some.

HyperTranscribe
PRAGMATIC TRANSCRIPTION SOFTWARE

H

yperTranscribe is a handy little app
that lets you watch a video or listen
to an audio ﬁle while you transcribe the
spoken words. Sure, you could switch
back and forth between QuickTime
Player or iTunes and a word processor,
but HyperTranscribe provides a single
interface and a few features to make the
task much easier.
HyperTranscribe’s interface has
two main components: the media
player (with time-code display) and a
transcription area. You load your media
(the app supports MP3, AIFF, WAV,
MPEG, AVI, and MOV), play it, and type
the words as you hear them. By default,
the ﬁle plays in ﬁveON THE
second chunks; you
DISC can repeat a segment
HyperTranscribe
by pressing ShiftCOMPANY: ResearchWare
CONTACT: 888-497-3737 or
781-961-3909, www.researchware.com
PRICE: $99
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spacebar, advance to the
next segment by pressing
Tab, or go back by pressing
Shift-Tab. Your hands never
have to leave the keyboard
unless you want to change
font settings.
You can create up to 10
shortcuts that let you insert
commonly used words by
typing a key combination.
For example, you can assign No more mailing away for an Oprah transcript.
Command-1 to your ﬁrst
shortcut interface—you have to format
speaker’s name, Command-2 to your
words in the transcript and then copy
second speaker’s, and so on. Shortcuts
them into the shortcut list.
aren’t unique to each transcript, so if
The bottom line. HyperTranscribe may
you’re working on multiple transcripts,
seem a bit pricey for what it does, but it’ll
you’ll have to decide which shortcuts
enhance productivity for transcribers.
to jettison if you reach the limit. Also,
—Roman Loyola
you can’t format shortcuts within the

REQUIREMENTS:
Mac OS 10.2 or later,
QuickTime 6 or later

GOOD NEWS: Easy to use.
BAD NEWS: Shortcuts aren’t unique to each transcript. Pricey.
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DictJuggler
REASSURING WEB-RESEARCH UTILITY

I

f you do research online, you’d
better double-check your sources.
For that, there’s DictJuggler. Designed
for easy online research, DictJuggler
gives you one-click access to 29 online
resources, including search engines,
encyclopedias, dictionaries, and
auction sites.
DictJuggler is basically two Web
browsers in one. Its main browser
window gives you most of the features
you ﬁnd in Safari, with the notable
exception of RSS feeds. When you run
across a word or phrase that sparks
your curiosity, double-click it to look
it up in the dictionary window, which
automatically searches the last research
site you used. To look up your query on
another site, just select one from the
COMPANY: Marlin Arms
CONTACT: www.marlin-arms.co.jp
PRICE: $29.95

drop-down menu, and your
query results appear instantly.
For fast searches, the Quick
Lookup panel lets you type
your query directly into the
dictionary window; the panel
then turns translucent so it
doesn’t obstruct your view.
Search several search engines and online dictionaries with
Despite its nifty search
one click.
functions, DictJuggler is a
name and URL of the site you want to
limited Web browser—don’t use it as
add, just as you would a bookmark. Your
a replacement for Safari or Firefox.
site will then appear in the dictionary
Fortunately, you can switch from the
window’s drop-down menu.
DictJuggler browser to your default
The bottom line. DictJuggler is a
browser by pressing Command-J.
handy tool for online research, but it’s
DictJuggler’s 29 preloaded search
not essential, especially if you’re already
sites cover a wide range of resources,
skilled with tabbed browsing in your
but you can add as many as you like in
existing browser.—Robert Strohmeyer
the Dictionary Manager. Just type the

REQUIREMENTS:
Mac OS 10.3.9 or later

GOOD NEWS: One-click access to the Net’s best research tools.
BAD NEWS: No support for RSS feeds.

iZ
WACKY iPOD SPEAKER

Z

izzle’s iZ is what the company calls
an “animatronic DJ” for kids. It can
play music from your iPod or create basic
songs (or drive you up a wall—Ed.). What
it’s modeled after, we’re not quite sure—
perhaps it’s the love child of Q-Bert
and Izzy, the 1996 Summer Olympics
mascot. iZ stands about nine inches
tall, and its plastic body comes in blue,
yellow, or red. Once you supply your
own set of four AA batteries and plug
in your iPod or any audio device with a
headphone jack, the fun (or ﬁngernailson-a-blackboard pain—Ed.) begins.
The garbled audio quality that comes
through iZ’s speaker won’t impress,
but you’ll be too busy playing with iZ’s
body parts (or strangling it—Ed.) to
notice. Snap at iZ’s Flicker (the thing that
hangs atop its head) and it makes goofy
COMPANY: Zizzle
CONTACT: 847-572-9300,
www.zizzle.com
PRICE: $39.99

50

April 2006

belching noises and whoops.
Push iZ’s belly, and it erupts
with (snicker-snicker-giggle) fart
sounds (hee-hee-hee) and other
kinds of noises you usually hear on
morning-zoo radio. (We’re talking
highly sophisticated wit,
folks.—Ed.)
You can also use iZ to create
songs. Press the center of
iZ’s belly to play one of
seven built-in beat
tracks. Press the top
of its belly, and your
music plays faster;
Three-legged, bugpress the bottom,
eyed, and ﬂatulent.
and the music slows
down; the right side controls the volume
(we suggest as low as possible—Ed.).
Fiddling with the beast’s right ear plays

REQUIREMENTS: Four AA
batteries, iPod or any audio device
with headphone jack

one of seven rhythm
tracks, and the left ear
plays one of seven lead tracks.
The resulting “tunes” are about
what you’d expect from a kids’
toys; it won’t prompt any
booties to shake at your local
dance club (though it might
get you shot at—Ed.). The
button combinations may
be too confounding for
young kids, but it’s easy
to save the songs
(though who’d
want to?—Ed.).
The bottom line. iZ is amusing for a
short time, but it may not be long before
iZ ﬁnds a place in the back of your kids’
closet (if dad doesn’t tear it limb from
limb ﬁrst—Ed.).—Roman Loyola

GOOD NEWS: Entertaining in a juvenile way. Farts are scentless.
BAD NEWS: High potential for annoyance. Poor to mediocre
sound quality.
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MacCapture
QUIRKY VIDEO-CAPTURE SOFTWARE

F

or its modest price, MacCapture lets
you create presentations that use
screen captures, digital video, voiceovers, image stills, text, and graphics—
but it has a few interface aberrations.
MacCapture does a credible job with
screen capture, and the process is
simple: Click the Record button in the
Controller window, deﬁne the area on
the screen you want to capture, and
then press the Return key. We did have
problems capturing digital video; we
couldn’t control a Canon XL1 digital
video camera through MacCapture’s
VCR-like onscreen buttons. We resorted
to using one hand to click the app’s
Record button and the other hand to
press play on the XL1. Another quirk:
After pushing MacCapture’s Stop button

to end video capture, there’s
no prompt to save and name
the clip—our ﬁrst thought was
that the capture failed.
Familiar tools such as the
Photoshop-inspired imageediting tool palette allow text
and paint-type graphics to be
What can you capture? Try video and your Mac’s screen,
laid over any video component. for starters.
Confusingly, when you enter
your clips into a presentation, you can
the app’s edit mode after capturing a
save your project as a QuickTime movie,
clip, the capture-tool windows don’t
or you can export to one of several
close—a second set of windows opens
formats, including MPEG-4, Windows
containing the tools palette and your
Media, and even a 320-by-240-pixel
captured clip. And although MacCapture
iPod-friendly format.
uses a timeline format, it lacks the
The bottom line. MacCapture is a
friendly precision of iMovie and other
few steps away from being a graceful
video editors. MacCapture does have one
tool.—Tom Lassiter and Roman Loyola
nice convenience: Once you’ve compiled

REQUIREMENTS: Mac OS 10.2.6
COMPANY: macXware
CONTACT: www.macxware.com or later, 128MB RAM, 20MB disk
space, QuickTime 5 or later
PRICE: $29.99

GOOD NEWS: Affordable. Captures onscreen activity.
BAD NEWS: Idiosyncratic interface.

One-Button Mouse
EASY-TO-USE POINTING DEVICE

I

n response to the lukewarm reception of its multibutton
Mighty Mouse (
Nov/05, p49), Apple has gone
back to basics with its One-Button Mouse. Its simplicity
and muscular styling will please both Mac purists and users
disappointed that the Mighty Mouse looks nothing like a
certain barrel-chested Terrytoons character.
Using the One-Button Mouse couldn’t
be easier—there’s no need to learn
any complex squeezing or scrolling
moves. The Mouse even replaces the
traditional optical sensor, which can
be ﬂummoxed by reﬂective or patterned
surfaces, with an ingenious roller-ball
system—it’s exactly the kind of innovative
thinking we’ve come to expect from Apple.
The bottom line. As da Vinci said, “Simplicity
Doug Engelbart
would be proud. is the ultimate sophistication.”—Nisan Budala
COMPANY: Apple
CONTACT: 800-795-1000 or
408-996-1010, www.apple.com

PRICE: $49
REQUIREMENTS:
Hand with at least one finger

GOOD NEWS: One-button simplicity.
Roller-ball technology works on most
surfaces.
BAD NEWS: Button is not programmable.
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iPod Radio
Remote
SERVICEABLE FM
TUNER AND REMOTE
FM, sure—but

T

he tiny iPod Radio Remote adds FM reception
forget about
to your iPod nano or video-capable iPod. Bundled
ball games.
with standard earbuds attached to a shorter cable,
the remote clips to your shirt, pocket, or whatever. When you plug
the remote into your iPod’s docking port, a Radio item appears in
the ’Pod’s main menu; select it, and the FM-tuning screen appears.
It’s a snap to select stations using the Click Wheel or mark favorite
stations and jump to them with the forward and back buttons on
either the iPod or the remote (which can also be used to control
your iPod). Unfortunately, although reception is excellent when
tuned to strong stations, weaker stations drift in and out.
The bottom line. The Radio Remote is elegant and easy to use,
but we expected better reception for 50 bucks.—Rik Myslewski
COMPANY: Apple
CONTACT: 800-795-1000 or
408-996-1010, www.apple.com

PRICE: $49
REQUIREMENTS: iPod nano or videocapable iPod, iPod software version 1.1 or later

GOOD NEWS: Easy-to-use. Favorite-station
capability. RDS display on iPod. Needs no batteries.
BAD NEWS: Iffy reception on weaker stations. No
AM mode. Only comes in white.
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because you play as hard as you work

TIPS & TRICKS

Quake 4
Quake 4 ($49.99, www.aspyr.com) is ﬁnally coming to
the Mac. For the uninitiated, Quake 4 chronicles the war
between the human race and an evil alien race called
the Strogg. It’s the sequel to Quake II—in Quakenese,
Quake 4 is really Quake 3, because Quake III Arena
doesn’t really count since it was focused on online
multiplayer and didn’t continue the Quake storyline.
Got it? If not, don’t worry about it. When you blast into
Quake 4 armed with these tips and shoot everything in
your way, the Strogg will have reason to worry.
—Matt Osborn
■ Enemies can easily dodge the slow-but-potent Dark
Matter Gun. Be sure of your aim.
■ Even though it’s not as high-tech as your other gear,
don’t underestimate your trusty shotgun.
■ The Hover Tank might be slow, but its shields
regenerate.
■ After “Stroggiﬁcation,” a soldier gets more health,
moves faster, and can read the Strogg language.
■ Fatty, the Strogg boss, is invincible, so don’t waste
your ammo.

X-Arcade Trackball Mouse
RETRO-COOL TRACKBALL

R

emember video arcades? The
machines, with their hypnotic
pulsing lights and sounds, would attract
you and suck the quarters from your
pockets. The world seemed to melt away
as you mashed those buttons. All those
memories rush back when you get ahold
of the X-Arcade Trackball Mouse.
The X-Arcade Trackball is made of
the same industrial-strength parts
used in arcade machines. The white
trackball is built into the center of
the unit, and three buttons ﬂank it on
either side—great for both righties and
lefties. There are also buttons hidden
under the lip on the left and right sides
that are perfect for pinball games.
Everything is encased in a heavy-duty,
15-pound, arcade-quality, plasticcoated wood base.
The Mac sees the Trackball Mouse as
a generic input device and thinks it’s a

Ah, arcade memories—the only
thing that’s missing is a slot for
your quarters.

mouse, with the Trackball’s middle
top buttons as the mouse buttons. You
can use it with any game that relies on
mouse control, but you probably don’t
want to use the Trackball for games
where it’s not appropriate, such as Doom
3—you can even use it with MacMAME
(free, www.macmame.org), which
emulates old arcade games such as
Crystal Castles, Missile Command, and
Centipede.
The only real issue with the X-Arcade
Trackball is that the Atari Anniversary
Edition games it comes with are not
Mac compatible. Some of the bundled
historical videos, however, are
watchable if you use the VLC (free,
www.videolan.org) media player.

The bottom line. If you’re looking for
a trackball for everyday use, this isn’t it.
But if you love retro games, welcome to
nostalgic heaven.—Matt Osborn
COMPANY: XGaming, 866-942-6464,
www.x-arcade.com
PRICE: $129.95
REQUIREMENTS: Mac OS 10.2.4 or later
GOOD NEWS: Sturdy construction.
BAD NEWS: Bundled games aren’t Mac compatible.

RATED

GREAT
April 2006
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because you play as hard as you work

RollerCoaster Tycoon 3
RIVETING SIMULATION GAME

You can experience any of the rides from the perspective of the CoasterCam.

D

espite the fact that RollerCoaster
Tycoon 3 is the third game of the
series, it’s the ﬁrst to appear on the
Mac. From building rides to controlling
ﬁnances, you get to play Michael Eisner
(oops, we mean Robert Iger) and manage
every aspect of an amusement park.
Your goal? Build thriving parks that make
lots of money so you can move up the
entrepreneurial ladder.
The game comes with 18 scenarios,
each with a different selection of roller
coasters, water rides, thrill rides, and
other attractions. Some attractions, such
as merry-go-rounds and pirate ships,
are simple: Just place them in your park,
and watch the public enjoy them. Other
attractions (for example, log ﬂumes and
coasters) involve more work—you design

them yourself by laying down each and
every piece of track. Luckily, all of that
hard work pays off—when you’re done,
you can go into CoasterCam mode to
experience your creation from a ﬁrstperson perspective. Whee!
Down to business. Of course, there
are other aspects to running a successful
amusement park. Each park needs
janitors, mechanics, and entertainers—
none of whom seem satisﬁed until you
raise their salaries or spend money on
training. You also need to set up food
and drink booths that sell refreshments
(food options change depending
on the scenario you’re playing) and
spend money to research concessions,
shopping, and rides to unlock more
choices in each scenario.

In order to make money, it’s important to
keep park attendance up by balancing how
much you spend on attractions versus how
much you charge parkgoers for smoothies
and rides. You can even start marketing
campaigns to draw more people.
While the rise to tycoonship is fun
and engrossing, we do have a few
gripes. For one, the game doesn’t always
respond quickly. Clicking an attraction,
for example, is supposed to bring up its
details panel, but it sometimes takes
several clicks before the game registers
your request. Also, the roller coaster–
building controls take some getting used
to—sometimes you think you’ve laid a
piece of track when you’ve really only
changed tools. And if you don’t have a twobutton mouse with a scroll wheel, you’d
better go buy one—many camera controls
require the scroll wheel or a right click.
The bottom line. From designing rides
to pricing a slice of meat pizza, we love the
level of micromanagement in RollerCoaster
Tycoon 3. The small details and sheer
amount of control will keep you parked at
your Mac for hours on end.—Cathy Lu
COMPANY: Aspyr, 512-708-8100, www.aspyr.com
PRICE: $49.99
REQUIREMENTS: 1GHz G4, Mac OS 10.3.9 or later,
256MB RAM, 2GB disk space, 32MB Radeon 9000
or GeForce FX5200 or better video card
GOOD NEWS: You can manage every aspect of your
park. CoasterCam lets you experience your own rides.
BAD NEWS: Doesn’t always respond to commands
pronto. Unintuitive tools for building roller coasters.

RATED

GREAT

COMING SOON

Good Heroes Never Die
The Heroes of Might and Magic series has long been a favorite among strategy fans. This
ﬁfth reincarnation promises not only to keep all of the core fantasy turn-based tactical
elements, but also improve upon them with 3D graphics (a ﬁrst for the series), diverse
races, faction abilities, and tons of the usual role-playing devices such as skills, spells, and
creatures. In the campaign mode, you develop towns and move your heroes with armies of
soldiers and mythical creatures in tow. When you meet another hero on the ﬁeld, your armies
clash on a chess-like map while your hero uses special abilities from the sidelines. Online
multiplayer modes include player vs. player, players vs. AI, hero duels, and an intriguing new
ghost mode that lets one player take on the role of the world’s creatures while another plays
the game the usual way.—Matt Osborn
HEROES OF MIGHT AND MAGIC V
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It would appear that might has
triumphed over magic ... this time.

COMPANY: Freeverse, www.freeverse.com ■ AVAILABLE: 2006 ■ PRICE: TBD
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The SpongeBob
SquarePants Movie

SIMPLE KIDS’ ADVENTURE GAME

You can experience any of the rides from the perspective of the CoasterCam.

SpongeBob, sans SquarePants.

E

veryone’s favorite bucktoothed
animated sea sponge has ﬁnally
invaded the Mac in this colorful kids’
game inspired by the 2004 theatrical
release of The SpongeBob SquarePants
Movie. You may be asking asking, “What
took so long?” The sad answer is that
lengthy delays are about par for the
course in the Mac gaming world.
If you haven’t seen the movie, be
prepared for some major spoilers in this
game. Just like in the TV show, a threeinch-tall evil genius named Plankton
is trying to rule the world. His current
scheme: Nab King Neptune’s crown
and blame Mr. Krabs, the owner of the
restaurant where SpongeBob works.
Only SpongeBob, his starﬁsh buddy
Patrick, and other Bikini Bottom cohorts
can stop Plankton’s plan for world
domination.
COMPANY: Aspyr, 512-708-8100, www.aspyr.com
PRICE: $29.99
REQUIREMENTS: 800MHz G4, Mac OS 10.3.9 or
later , 256MB RAM, 1GB disk space, ATI Radeon
8500 or nVidia GeForce2 MX video card or better
GOOD NEWS: Replicates the feel of the cartoon
series and the movie.
BAD NEWS: Overly simplistic. Odd pacing. Minigames are too few and far between.

RATED

SOLID

You can play as SpongeBob, Patrick,
Mindy (King Neptune’s daughter),
SpongeBob’s friend Sandy Cheeks, or
the sinister Plankton, as well. Much like
LucasArts’ old-school Monkey Island
graphic-adventure games, the gameplay

involves simple pointing and clicking
to move your character and interact
with objects. Sometimes you’ll need
to combine multiple items from the
environment with junk in your inventory
to solve puzzles and proceed. The
puzzles can be a bit tedious, and the
tasks are extremely simplistic (even
for a children’s game), but luckily
there are mini-games (such as piloting
Plankton’s jet pack) to break up the
puzzle-driven monotony—though those
mini-games come few and far between.
What really works is the level of
detail in SpongeBob’s world. The 2D
hand-drawn backgrounds, sense of
humor, playful music, and especially
the voice acting all combine to make
you feel like you’re really in the TV
show—without the commercials.
The bottom line. If you love
SpongeBob SquarePants and dig oldschool graphic adventures, then this is
the game for you. If you’re looking for
more challenge or action (or you simply
hate the yellow absorbent one), just
ﬂoat on by.—Matt Osborn

COMING SOON

A Roman, a Celt, and a Gaul
Walk into a Bar…
While you may never actually get to relive the spendor, glory, and battles of the
Roman Empire, this historic real-time strategy game might be the next best thing.
The game features two campaigns: one that follows the rise of Rome, and one in
which you play the Gauls, leading Celtic tribes against the Roman war machine. All
the strategy takes place in real time, and
although you won’t be micromanaging
any resources, your victories will earn
you experience points, money, and
fame. You can then spend these to
customize your squads with over 100
RPG-ish skills, such as improved criticalhit ratios and anti-cavalry specials. You
can even design specialized squads for
online multiplayer matches—just be sure
to watch out for the Naked Fanatics.
None of these fanatics are naked, but
—Matt Osborn
Legion Arena has its share of nudists.
LEGION
ARENA

COMPANY: Freeverse, www.legionarena.com
AVAILABLE: 2006 ■ PRICE: TBD
April 2006
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because inquiring minds have the right to be inspired
EasyFind (free, on the Disc, www
.grunenberg.com/mainmenu.html).
This little app can search by ﬁle name,
folder name, contents, using Boolean
operators, or even for items hidden
in Packages—Spotlight can’t do that.
EasyFind even waits for you to ﬁnish
typing rather than hog-tying your system
searching for the ﬁrst letter you type.

SLEEP SOUNDLY

RAM IT
I want to upgrade my iMac’s RAM.
What’s this I hear about using matching
pairs of chips?
Most Power Mac G5s require matched
pairs of RAM modules, but iMacs don’t
really care how you conﬁgure RAM—the
only rule that holds true is “get as
much RAM as you can.” That said,
matched RAM theoretically functions
more efﬁciently than unmatched RAM
(unmatched RAM uses a 64-bit data
path, and matched RAM uses a 128-bit
data path, if you must know). But in the
real world, you probably won’t notice
the difference.

FIND A BETTER FIND
I love Tiger, but I hate Spotlight. Is
there a way to go back to the old Find?
Spotlight shows tremendous potential
and is truly the future of searching on
the Mac—but for now, its “gotchas”
sometimes make it more trouble than
it’s worth. If you’re
ON THE
looking for a quick
DISC and easy way to
EasyFind
ﬁnd your stuff, try

Need to ﬁnd a better Spotlight?

PASSWORD WANTED
I remember reading about an automatic
password generator in Mac OS X.
Where the heck is it?
Apple’s Password Assistant is cleverly
hidden inside the Keychain Access
utility (/Applications/Utilities), which,
if you didn’t know, is speciﬁcally
designed for maintaining passwords
and security certiﬁcates on your Mac. To
get to the random-password generator,
launch Keychain Access and select File >
New Password Item from the menu bar.
Fill in the Keychain Item and Account
Name ﬁelds if you want to use Keychain
Access to manage this password;

Gibberish? Maybe. But who’d ever guess
a password like this?

SAY WHAT?

UP TO SNUFF?
Can I run Apple’s new Aperture photo
app on my Mac?
Aperture is one power-hungry app.
To ﬁnd out if your Mac can handle it,
download Apple’s Aperture Compatibility
Checker (free, www.apple.com/aperture/
binary/Aperture_Checker.dmg).
52
58

otherwise, go straight to the little key
icon on the right-hand side to bring up
the Password Assistant, and use the
Assistant’s pull-down menu and Length
slider to tweak the password. Now you
can copy (Command-C) the supplied
password and paste it into a password
ﬁeld. And if you don’t add it to your
Password Keychain, make sure you take
a few hours to memorize the string of
nonsense.

August
April
2006
2005

I heard I could control my Mac with just
my voice. Is this true?
It’s true. Open System Preferences >
Speech, and then click the Speech
Recognition tab. Click the Speakable
Items On button, and dig into the

Can I set my Mac to require a password
when waking from sleep?
Absolutely. In fact, this is a great way
to keep your private information (such
as your work-time surﬁng habits) away

You’ll want to keep track of this password.

from the other drones in your ofﬁce or
classroom. To batten down your Mac’s
hatches, go to System Preferences >
Security; in the subsequent window,
check the box labeled Require Password
To Wake This Computer From Sleep Or
Screen Saver. The next time you wake
up the Mac, it’ll balk until you enter
your regular login information. Want a
heinously secure password? See the
previous question.

Commands and Settings panes to see
what you can do vocally.

A BITTER LESSON
My coffee is bitter and weak. What am
I doing wrong?
Try wetting the grounds with cold water
before you brew.

DISC DODGE
This mic icon
means your Mac
is listening.

Can I import videos I buy from the
iTunes Music Store into iDVD and burn
discs to watch on my TV?
Sorry, but no—iTMS videos only work on
your Mac or a video-capable iPod.

DIFFICULTY
RATINGS

No whining—
anyone
can do this!

BROWSE IN NINE
I still use Mac OS 9. What’s the best
Web browser these days?
Web technologies continue to evolve,
but Web browsers for Mac OS 9 have
pretty much been put out to pasture—
just like OS 9 itself. Only one Web
browser that we know of is still being
maintained for OS 9: the venerable iCab
(www.icab.de), available for $29—or
for free if you don’t mind being down
a feature or three. Surprisingly, iCab
handles the modern Web and its arcane
technologies remarkably well.

SWITCHING
Is there a way to switch to another account
on my Mac without having to quit all my
apps, log out, and log back in again?
There sure is: It’s called Fast User
Switching, and it allows you to switch
users without quitting all your open
applications and properly logging out.
To enable it, open System Preferences
> Accounts, click the little golden
padlock open, and authenticate your
administrator status. Now click Login

It’ll take some
effort, but you
can do it.
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This stuff’s
for the pros.

UNIX UNIVERSITY
UNIX UNIVERSITY
Is it possible to use my Mac’s CD burner
from the Unix command-line interface in the Terminal?
to burn; drag that ﬁle or folder into the
Your Mac’s CD or DVD burner is
Terminal window to automatically ﬁll
completely available from the Unix
out the ﬁle path. Now your command
command line—all you need is the
will now look like so: drutil burn
drutil utility in the Terminal. First,
/Users/user name/Desktop/ﬁle
launch the Terminal (/Applications/
or folder name/. You’ll notice that
Utilities); then type drutil and
press Return. This will list all the
any spaces in your ﬁle or folder name
commands you can execute using the
will be preceded by the backslash
drutil utility. To burn a ﬁle or folder
(\) character. Press Return, and the
to a disc, type drutil burn at the
Terminal will ask you to insert a disc
Terminal prompt—but don’t press
into the drive. Put in a blank disc,
Return yet. Now go back to the Finder
and watch your burn’s progress in
and ﬁnd the ﬁle or folder you want
the Terminal window.

Disc burning,
Terminal style.

Options and check the box labeled Enable
Fast User Switching in the resulting pane.

MAC 411
Bonus: You’ll never forget your name again.

How can I tell the speed of my new Mac?
Choose About This Mac from the Apple
menu. In the dialog that appears,

KEY QUERY

STANDARD WHAT?

Do you know of an inexpensive MIDI/
USB keyboard I can hook up to my iMac
to use with GarageBand?
M-Audio’s cute little eKeys 37 ($59.95,
www.m-audio.com) has 37 cute little
keys and works great with GarageBand.

What are all these Web standards
I keep hearing about?
If anyone’s in charge of the Web,
it’s the W3C, aka World Wide Web
Consortium (www.w3.org). This
independent organization keeps its
ﬁnger on the pulse of developing
Web technologies and makes ofﬁcial
recommendations for standards
(such as HTML 4.0) that browser
makers and Web designers should
stick to.

Your new
18-inch sideman.

there’ll be a number next to Processor
that indicates your Mac’s speed in
megahertz (MHz) or gigahertz (GHz).
Click the More Info button to launch
System Proﬁler
and get more
data about
your Mac than
you’ll probably
ever need.
Reveal your
Mac’s inner
monster.
Buz Zoller is a graphic designer living in
Florida. He has been a devoted Mac
user for over 10 years and has worked for
both Apple and Power Computing.

Submit

technical questions
or helpful tips directly
via email (askus@macaddict.com) or c/o
MacAddict, 4000 Shoreline Court., Ste.
400, South San Francisco, CA 94080.

April 2006
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HOW TO

create killer charts

Create Killer Charts
by John Brandon and Niko Coucouvanis
UTILITIES:
Click here to
access the quick
Outliner tool and
Layers manager.

STYLE INSPECTOR:
Suss your stuff
and make stylistic
changes.

STATUS BAR:
Look here for
basic layer and
selection info.

PROPERTIES
INSPECTOR:
Tweak box
geometry,
Connector
behavior, and
Actions here.

ACTION ICON:
Indicates that
an object has
an associated
clickable Action.
MAGNIFICATION:
When your chart
gets big, shrink
the view.

STENCIL: Find
ﬂowchart building
blocks and
connectors.

OmniGrafﬂe makes it easy to chart your way to productivity.

CANVAS
INSPECTOR:
Alter your page
size, alignment,
orientation, grid
behavior, and
diagram layout.

WHAT YOU NEED
OmniGraffle 4.1 ($79.95, on the Disc,
www.omnigroup.com)
Mac OS 10.3.9 or later
Enough of a plan to make a flowchart

A

ON THE

DISC
OmniGrafﬂe

picture’s worth a thousand words—and at the rate
attention spans are shrinking, visual ﬂowcharts may
soon be the only practical means of communication.
Whether you’re planning your day, designing a computer
network, charting your family tree, or determining how many
degrees of separation exist between you and the Antichrist (aka

1

Orientation Station

Flowcharts are, by
deﬁnition, born to ﬂow.
Start off right by specifying
page orientation (portrait
or landscape), page size,
margins, print scale, layout
grid, and other document
parameters in the Canvas
Inspector. Even if you don’t
plan on printing your chart
(although OmniGrafﬂe charts
print fabulously), setting some
boundaries keeps everything
copacetic. You can always
tweak these settings later
through the Canvas Inspector.
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Scott Baio), ﬂowcharts make everything smoother. Here’s how
to use OmniGrafﬂe to diagram your chaos into order.
Begin by installing OmniGrafﬂe ($79.95, free trial on the
Disc, www.omnigroup.com). Launch it, close the sample
document (Command-W), create a new one (Command-N),
and start chartin’!

2

Do the View

OmniGrafﬂe’s various
View options can help
streamline your grafﬂing; use
the View menu to activate or
deactivate the Status Bar and
visual indicators for Actions, Grid,
Magnets, Page Breaks, and Rulers.
Got a honkin’ big project? Turn
on Rulers (View > Rulers, or press
Command-R) and use the pulldown menu to change ruler units
to Feet, Yards, or Miles—that’s
one big chart.
A little preparation in the
Canvas Inspector helps keep
your chart manageable.

Set your ruler units to Miles if you’re
charting your next crop-circle raid.
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3

Let It Flow

If you don’t see the Inspector and Stencils windows, click
the Inspect and Stencils icons in OmniGrafﬂe’s toolbar.
In the Stencil window, select Business > Organizational Chart
to load the org-chart stencils. Drag one into the window, where
you’re free to position and resize at will. To edit the placeholder
text, simply double-click it and type away. To add connectors,
select Basic from the Stencils pull-down menu; when you drag a
connector into the chart, notice the red and greenish dots on the
ends: Place the red dot on the parent in the relationship and the
greenish dot on the child. You can further spifﬁfy the chart with
the multifaceted Properties and Style Inspectors—but ﬁrst, we’ll
show you a more formal way to chart the ﬂow.

Red rules: Connector hierarchy ﬂows from
the red dot to the greenish one.

5

Style Your Profile

4

Chart by the Books

6

Pretty It Up

If you have a speciﬁc hierarchy or progression in mind
for your chart, press the Utilities button and dig into the
Outliner. With this method, you simply add your ﬁrst Topic (click
the plus sign) and use the Action menu (click the gear icon) to
add topics designated Child, Sibling, Spouse, Aunt, and Parent
(sorry, no kissin’ cousins—and, yes, these wacky relationship
terms mean pretty much what you’d expect). OmniGrafﬂe adds
the appropriate connectors automatically. You can still drag
the topics and connectors around
the window, but using Outline has
a hidden bonus: Open the Canvas
Inspector’s Diagram Layout section
(Shift-Command-L) and impose a
structure on your chart (if you’ve
nudged things around, this’ll set
them straight), or pick an entirely
You can go the other route
different layout. When you click Lay
and enforce strict parentOut Now, OmniGrafﬂe will snap your child relationships on your
chart’s items into perfect position.
chartees.

OmniGrafﬂe’s Style Inspector is pretty self-explanatory;
move your cursor over the main icons to reveal their
purposes, and set a text box’s Fill, Shadow, Lines And Shapes,
Image, and Text attributes. The trick is getting consistent styles
across multiple items in the
chart—but as luck would have
it, we’ve got two tricks for style
propagation: If you’ve crafted the
perfect style on one text box, click
the Style Summary icon. The panel
will show all of the styles you’ve
applied to the selected box and a
cumulative All Styles icon—simply
drag the All Styles icon onto any
text box to replicate the style. Or
plan ahead and select multiple text Shift-select multiple items to
boxes before digging into the Style apply styles in bulk, or select
Inspector. All of the selected items a styled item and drag its
will adopt your Style changes.
styles onto other items.

If you’re making a business-org chart (and you don’t
live in Cuba), you’ll want to designate different classes
or levels of employees, each with a different look for quick
identiﬁcation. Select one of the head-and-shoulders-silhouette
objects in your document, and click the Images icon in the Style
Inspector. To change the image, click the Image check box to
remove the current image, and then click it again—OmniGrafﬂe
presents a Set Image dialog with which you can navigate to an
image ﬁle on your Mac. Use the Inspector’s pull-down menu and
text ﬁelds to tweak
the image’s placement
and opacity, or click
and drag in the
preview window to
reposition the image
in its box onscreen.

7

8

Bust Out a Background

As long as you’re prettying up your chart, you might as
well add a background image. Click the Utilities icon. In
the Layers section, click the plus-sign button to add a new layer
above the current layer. Now drag an image from the Finder into
your OmniGrafﬂe document to
place it on the new layer, or select
File > Place Image to navigate to an
image. Drag the new layer’s icon to
the bottom of the list of layers to
make it the background; you can
always size, shape, and style it to
your liking later. While messing
with the Layers manager, note that
you can also set a background
color via the Background box at
Good taste is key when you
the bottom of the window.
choose a background image.
Niko Coucouvanis never thought he’d get excited about
making ﬂowcharts, but OmniGrafﬂe changed that.

You can look as good
as you want to look.

Poke Around the Properties Inspector

Hidden in the Properties Inspector is one of OmniGrafﬂe’s
coolest tools: Action. With an object selected in the main
window, click the Properties Inspector’s Action icon, and use the
pull-down menu to specify
what should happen when
you click that object with the
Browse tool: You can open a
ﬁle, launch a Web site in your
browser, run a script, or jump
to a different object or point
in the chart. This feature’s
got “interactive storyboard”
written all over it.
Add some action to make
your chart interactive.
April 2006
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pitch a tent for better macros

Pitch a Tent for Better Macros
by Niko Coucouvanis
WHAT YOU NEED
Decent camera, preferably with a macro lens
3/4-inch PVC pipe (26 cents per foot) and T-joints ($2 for 10)
Ripstop nylon or similar fabric (such as a shower curtain)
Velcro tape (or other fastening system)
Big, sturdy table to work on

S
1

PVC for You and Me

Rather than messing with a hammer and nails, it’s
easier to frame your box with good old PVC pipe. Home
Depot has every ﬂavor of PVC known to man. We used 3/4-inchdiameter tubing for our smallish box. Get the stronger, one-inchdiameter PVC if you want to make your box big enough to stand
in. PVC is super-easy to cut with a wood saw, or you can buy
it precut; either way, you need eight two-foot lengths of pipe,
eight T-joints, and four two-inch shims to connect the T-joints.

Got some antique bottles to sell on eBay? Photograph ’em
better in a light tent.

2

Four Corners Make It a Box

Assemble your box according to the photo below. The
PVC ﬁts together tightly enough to frame the box, but
you can still fold in the side walls and stash your box behind a
door. Note the dual T-joint conﬁguration on each corner post:
We used the upper set to
hang the sides and the
lower set for the top, but
you’re free to experiment.
However you build it,
make sure to jam the pipe
ﬁrmly into the T-joints—
we tapped ours in with
a hammer.
You can ﬂatten your tent
and stash it under the bed.

Sixteen feet of PVC pipe and eight T-joints form the frame.

3

Just Add Walls

Since you’re building this box to diffuse light, use
material that’s heavy enough to evenly disperse your
ﬂash or whatever light source you use. Ripstop nylon is ideal;
heavy cotton sheets work in a pinch; thin, sheer fabrics like
silk and linen won’t completely neuter the ﬂash and will likely
create a hotspot. Attach the two side panels with tape if you’re
in a hurry, or use Velcro tape
if you think you’ll ever want
to change your material to a
different color or weight for
special lighting effects.
If you want to skip the tape,
just drape a big sheet of nylon
over the top and call it a day.
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4

Top ’Er Off

Instead of taping the top and back pieces, cut the nylon
long enough to span the back and top—for our box, we
used four feet and left extra nylon to drape over the front and
sides. Now stretch the fabric across the box’s top (tightly, but
not too tightly), cut one-inch holes above each corner, and ﬁt
the holes over
the protruding
bits of PVC.
Unless you
plan on using
your light tent
outside, you
don’t need to
tape the top.

One day, Niko Coucouvanis will live in a home
made entirely of PVC.

o you got yourself a digital SLR camera and you think
you’re big stuff? Yeah, whatever. The cool kids are into
macrophotography—super-close-ups of coins, bugs,
ﬂowers, whatever. The best way to capture such small
fragments of the world is to isolate your subject in a light tent: a
mini tabletop photo studio with light-diffusing walls. Place a few
remote ﬂash units (or table lamps) outside the tent, and marvel
at your in-tent subject’s perfectly even light.
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migrate to a new Mac

Migrate to a New Mac
by Niko Coucouvanis
WHAT YOU NEED
An old Mac running Mac OS 10.1 or later
A new Mac running Mac OS 10.3.4 or later
FireWire cable

Migration is simple—if you take the
right pre- and post-migration steps.

1

Ground Rules

If you’re nervous about moving all of your stuff in
one fell swoop, note that Migration Assistant is quite
ﬂexible; you can launch it any time (/Applications/Utilities), and
move your choice of User accounts, Applications, Network and
Machine Settings, Files, or Volumes from another Mac or from
another volume on the same Mac. Whenever you use Migration
Assistant, disconnect any
external FireWire drives,
and if you’re paranoid
(or if the migration stalls
out), check Apple’s OS
X Firmware Updates
page (http://docs
.info.apple.com/article
.html?artnum=86117)
for an update to the
Get your ducks (and metaphors) in a
row so you can hit the ground running. older Mac’s ﬁrmware.

2

Don’t Move a Mess

Before you begin the migration, tidy up a bit. Start by
running Mac OS X’s regular maintenance procedures.
Fire up the Terminal (/Applications/Utilities), type sudo
periodic daily weekly monthly, and press Return. Enter an
Administrator password, and press Return again to run all of
your Mac’s regular maintenance scripts; the Terminal will get to
work without providing
any visual feedback other
than your short-name
prompt when it’s ﬁnished,
which could take as long
as 30 minutes. For another
ounce of prevention, open
Disk Utility (/Applications/
Utilities), select your hard
Your Mac may be running perfectly,
but mismatched permissions are just drive, and click Repair
Permissions.
waiting to monkey-wrench it.

3

Legal Proceedings

4

Scorched-Earth Policy

Before giving away your old Mac, Johnny Law says you
must remove any software that didn’t come with the
Mac, unless you fork over the original discs (and don’t install
the software on your new Mac). Apps like Adobe Creative Suite
and Studio MX 2004 provide easy activation and deactivation
via their Help menus; if you’re keeping the old Mac for yourself,
some apps permit multiple installations provided you only
use one at a time. If you’re giving your old Mac to a friend and
it contains music
bought from the
iTunes Music Store,
launch iTunes and
select Advanced
> Deauthorize
Whether you do it for legal or personal
reasons, get your stuff out of the old joint. Computer.
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To thoroughly wipe all evidence of your prior existence
from your trusty old Mac, reinstall the OS that came
with that Mac. Put the install disc in your old Mac and restart
(hold the C key to boot from the disc, if you need to). Before
installing, select Utilities > Disk Utility and erase the hard drive.
Click Security Options and
select how thoroughly you
want everything scrubbed.
Just remember that a highgrade thrashing could
take hours.
Remove every trace of
yourself in case your old
Mac falls into evil hands.

Having migrated to California from Iowa, Niko
Coucouvanis ﬁgures his next upgrade must be to Hawaii.

ILLUSTRATION BY SUSAN SYNARSKI

A

s of Mac OS 10.3.4, Apple’s Migration Assistant makes
transplanting the stuff from your trusty old Mac to
your shiny new one easier than changing your shorts.
(If the Migration Assistant doesn’t auto-launch on
your new or OS-upgraded Mac, ﬁnd it in /Applications/Utilities,
and follow its onscreen directions.) What Apple doesn’t tell
you, though, is what else you need to do to facilitate the move
or how to protect the data on your old Mac. Here’s what to do
before and after migrating from Mac to Mac.

!
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your new favorite game site

Tons of console and PC game news, reviews,
previews, trailers, screenshots, guides and more.
All free!

www gamesradar com

FROM THE CREATORS OF

Left

Serving the Mac Universe since 1988

visit macsales.com 800.275.4576

SuperDrive Your Mac
From Only $52.99!

Memory

More Memory for a Faster Mac!

Make Music, Movies & More
Add a Fast SuperDrive to your
Mac to Burn CDs, DVDs, even
8.5GB Dual Layer DVDs!

From the min to the Max - OWC has the
right Memory for your Apple.

For NEW 2006 MacBook Pro
and iMac Intel models:
PC5300 DDR2 667MHz 200 Pin
512MB Modules only $59.99
1.0GB Modules only $119.99
2.0GB Set only $239.00

Internal &
External Options
for nearly EVERY
Apple Laptop &
Desktop made!

For PowerMac G5 and
iMac G5 Models:

512MB DIMM from $49.00
1.0GB DIMM from $92.99
1.0GB Pair (512x2) from $95.00
2.0GB Pair (1GBx2) from $185.00
2.0GB DIMM from $249.00
4.0GB Pair (2GBx2) from $495.00

For PowerMac G4, iMac G4,
eMac G4, Mac mini:

External for any Mac (or
PC) with an available
FireWire/USB 2.0 port.

256MB from $25.00
512MB from $49.00
1GB from $89.99

You can use Apple’s iDVD,
iPhoto, iTunes, Discburner,
etc; Roxio Toast; nearly
any CD/DVD authorizing
software available!

For PowerBook 12/15/17;
iBook G3/G4s:

512MB Modules from $49.00
1GB Modules from $115.99
2GB Sets from $229.00

media, cases & label
kits in stock too!

macsales.com/superdrive

Not sure what upgrade is
best for your computer?

Lifetime Advance Replacement Warranty.

Then visit My OWC
Upgrade Center and
buy with confidence!

Call 800-275-4576 or
visit www.macsales.
com/memory and use
our online guide
to get the right
memory for your Mac!

macsales.com/MyOWC
MA_04-06
Your Online Mac Upgrade Center
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Hard Drives
Internal Hard Drives

Bulk up your computer by giving it higher capacity
to perform for your needs.

For iMacs, eMacs & PowerMacs

3.5" Plug
& Play 80GB
to 500GB
from $59

Highly Reliable, High-Performance, Plug & Play
- FireWire & USB2 External Storage Solutions
Add up to 1 Terabyte - 1000GBs - for your Audio/Video, Backup, Music, Additional
Storage Needs, etc with a top rated OWC or NewerTech Storage Solution.
Exclusively using the latest Oxford Chipsets and the the latest Hitachi and Seagate
drives, these solutions are built to last. All solutions are EMC/Dantz Retrospect
Backup Certified and backed with up to a 2 Year OWC or NewerTech Warranty.
OWC Mercury Elite-AL Pro up to 500GB
FireWire 400+USB2 Solutions from $129.99
FireWire 800/400 Solutions from $149.99
FireWire 800/400/USB2 Solutions from $159.99
Add your own HD Enclosure Kits from $79.99

For PowerBooks, iBooks & Mac mini

2.5" 40GB &
up to 160GB
from $79.95

OWC Mercury Elite-AL 800 Pro RAID up to
1TB(1000GB)
FireWire 800/400 Solutions from $239.99
Add your own HD Two-Bay Enclosure Kits $119.99
1
2

Not sure what
your Mac takes?

Buy with Confidence, call or
use our online guides.
macsales.com/harddrives

OWC Mercury On-the-Go Portable up to 160GB
FireWire 800/400/USB2 from $149.99
FireWire / FireWire 400/USB2 up to 120GB from $129.99
Add your own HD Enclosure Kits from $59.99

Hard Drive Controllers
Hard Disk Controller Cards

Serial ATA 4-Channel PCI-M $79.95

The ONLY
Pocket-Sized
Solution up
to 160GB!

Tempo ATA & SATA Mac PCI Controllers
Tempo Trio FireWire/USB2/ATA-133
all in one PCI $149.00

FirmTek

4-Channel SATA Controllers
from $119.95

See the full
line of OWC
FireWire solutions,
as well as solutions
by LaCie, EZ Quest,
SmartDisk, and
Wiebetech online at
macsales.com/FireWire

SATA Internal Mounting System
Sonnet G5 Jive, add 3 SATA HDs to
PowerMac G5 $95.00

SATA External Enclosures

FirmTek

Dual-Bay Hot Swap External Serial ATA
Enclosure with SATA PCI Controller Card $257.95

5 out of 5

Neptune
FireWire 400 solutions
from $99.95, Add your
own HD Enclosure Kits
just $47.99

Sonnet Fusion 4-Bay SATA Kit $549.00

Hard Drive
Enclosures
OWC Mercury Elite
SATA RAID Solutions
Perfect for Mass Storage
or RAID. Cables included.
1 Year OWC Warranty

OWC Mercury Elite Pro 'Classic' up to 400GB
FireWire 400+USB2 Solutions from $129.99
FireWire 800/400 Solutions from $159.99
FireWire 800/400/USB2 Solutions from $169.99
Add your own HD Enclosure Kits from $79.99

5 out of 5

Starting from

$79.95

1
2

NewerTech miniStack™ V2 FireWire+USB2 Solutions
with integrated FireWire and USB2 Hubs bring high
performance storage and port convenience with
solutions up to 500GB from $135.99
Add your own HD Enclosure Kits $79.95

ADD FIREWIRE & USB
to your Mac!
FireWire from $9.95
FireWire+USB Combos
from $29.99

Fan Exhaust Port

Connection Switch

™ V2

Security Slot

Macworld
Magazine

Drive Genius

December 2005

0

Retail $99.95 $65.0
Maintains, Manages,
Optimizes, Repairs.
Keep your Hard Drives
at their best. Recover
data if disaster strikes!

'Top Product'

Power Switch

Sp e c ia
35% O ffl OWC
O nly $6! N ow
5.0 0

USB 2.0 Ports

Power Receptacle

FireWire 400 Ports

FireWire 400 Port

USB 2.0 Port

USB 2.0 Uplink Port

Solutions include all cables, Dantz Retrospect Backup, Intech HD Speedtools and are
preformatted with free bonus software loaded all ready to plug and play your PowerMac,
PowerBook, iMac, iBook, or eMac too.

Prices, specifications and availability are subject to change without notice. Items returned within 30 days may be subject to a restocking fee.
No return will be accepted without Return Merchandise Authorization number.
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Mac Improvement

Mod your iPod

Laptop Batteries

From High Capacity Batteries to cases, Other World Computing has you covered in
keeping your iPod looking stylish as well as getting more playing time.

RoadTrip & RoadTrip Plus
Listen to your iPod on-the-road!

iPod Replacement Battery Kits

Easy to Install, Tools Included + Online
Installation Videos. Get up to 78%
more capacity & 20+ Hours Runtime!
iPod Batteries
for nearly every
Apple iPod
Starting From

OWC’s full line
of iPod Batteries,
Accessories, and
more online at
macsales.com/iPod

Finally, an easy to use and GREAT
sounding FM Transmitter for your iPod!
Just plug, tune a single station and jam
on without interruption. Easier to use
and sounds better than products costing
2 times as much!
RoadTrip!+
FM Transmitter
+ iPod Charger
Only

Not comfortable
opening your iPod?
For $39 + the cost of the
battery, OWC installs it for
you - iPod shipping Box and
FedEx Overnight covered
to and from!
macsales.com/iPodinstall

$14.99

$25.99

Tom Keating of
TMCnet.com had this to
say about the RoadTrip!+
"The RoadTrip!+ FM
Modulator worked
flawlessly... and I was very
impressed with
the sound quality."

iPod cases

Ozone USB Audio
8 Midi Controller
Knobs $249.00

Shuttle Pro v2
Jog/Shuttle
(15 programmable buttons)
$84.99

Shuttle Express
Jog/Shuttle (5
programmable
buttons) $39.99

Pay less. Get more. Surf faster!

5

from only

$

per month!

High-Speed Nationwide Dial-up
and DSL Services
Toll-Free Tech Support & More
from Mac Experts
Visit FasterMac.net or call toll free
800-869-9152 to learn more or to sign up.

Apple OS X ‘Tiger’ $99.00
full retail box version
OS X 10.2, 10.3 from $17.99

The latest Mac titles
from $9.95 Over 30 Mac

Titles In Stock!

Mac mini upgrades
Upgrade to 1GB only $93.95
More Memory = Much Faster!
™

Get a Bigger & Faster
Hard Drive from $79.99

From $79.95

V2

Macworld
Magazine
December 2005

'Top Product'

More Storage that’s up to 43.8% Faster!

Burn DVDs & CDs for only $119.99
8X DVD Burner is twice as fast as Apple’s current
SuperDrive option + supports Dual Layer DVD Burning!

Call or Visit macsales.com/macmini

The Latest Enhancements
Village Tronic VTBook

Add another CRT or Flat Panel Display to your
Powerbook $246.99

Instant Music
for Mac $41.99

iLugger iMac cases

Apple iLife '06
Make the most out of
your digital life. Share
the magic of
NEW!
your everyday
iLife '06
with iLife ’06.
$79.00
Only $79.00

MA_04-06
Your Online Mac Upgrade Center
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Network Adapters

Exclusive OWC Online Video shows how to install these Mac
mini upgrades or for $99 including overnight pickup and
return delivery, OWC will do the Mac mini upgrades for you!

macsales.com/osx

EyeTV Video Encoder /
TV Tuner/Digital Recorder
$149.99
EyeTV 200 $295.00
EyeTV 500 High-Definition
$339.00

Stops
marks!

The OWC LSPs are precision cut, glove soft leather
protectors that prevent potentially permanent marks
which can occur from the trackpad and keyboard while
your laptop is closed.

Logitech Cordless ‘Click’ Optical Mouse
for USB SPECIAL $15.99

Software
Shuttle A/V Controllers

PowerBook G4 17" $17.99
PowerBook G4 15" $17.95
PowerBook G3 15" $14.99
iBook/PowerBook G4 12" $13.95

O'Reilly Books

Mac-Only
Internet

Trigger Finger MIDI
Controller Input
Device $199.00

Protect your screen! There’s an OWC Laptop
Screen Protector (LSP) product for your Mac.

Wireless Mouse

Music on your Mac

StudioPro 4 Desktop
Audio Powered
Monitors $149.00

Laptop Screen Protectors

Is your Mac forgetting what time it is?
OWC PRAM batteries starting at $4.99

$14.99

Nova Large
Capsule Cardioid
Microphone $99.00

Call or Visit macsales.com/NewerTech

PRAM Batteries
RoadTrip!
FM Transmitter
For ALL Apple iPods
Only

macsales.com/music

PowerBook G4 Ti from $139.99
PowerBook 12/15/17" from $129.99
iBook G3/G4 from $119.99

D-Link 10/100
Ethernet PCI Card $9.99

Contour
Design
iSee

XtremeMac Sport
Wrap Armband

Batteries that Run Longer and
Last Longer! Built in the USA and
Built Right for up to 55% more
runtime vs. your original Apple
Stock Battery!

Left

6.25"

iPod Replacement Batteries
& Enrichment Products

2.50"

1.75"

for the iMac G5 or for Mac mini and/or up
to 20” LCD Display 5 color combinations
starting at $99.95

Rain Design i360°
A Turntable for your
iMac G5 17"and 20"
$39.00

Eye candies for
your iMac. Six
to choose from.

5
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Explore with your G4
OWC is the Apple Upgrades Expert! We know how to make
your Mac a Faster Mac. And it’s really amazing too – with a new
processor, your Mac can be like new again – even better than new
as it’s possible for it to be FASTER than even a brand new Mac too.
With 30 Days to try and a full 100% refund if it’s not for you
– you've got nothing to lose except that spinning beach ball.

ATI MacEdition
Performance Video Cards
When your Mac is Fast, Don’t let a
SLOW video card hold you back!
PCI Video Upgrade for Performance
or Additional Displays:
ATI Radeon 9200
w/128MB for any
Mac with an Available
PCI Slot $127.95
Up to 2048x1536
resolution.
Compatible with up to 24”
Displays!

High-Performance AGP Video
Card Upgrades
*All of the following
support up to
two displays*
ATI Radeon x800
MacEdition
with 256MB $449.00
TOP OF THE LINE G5
VIDEO Card supports up
to Apple’s 30” Display!
For PowerMac G5 Only.

For all PowerMac G4
Models:
ATI Radeon 9600 $79.00

OWC Stocks the full line of G3 & G4 Processorupgrades by these leading manufacturers:

G4 Single Upgrades from $195.00; G4/1.6GHz only $249.00
Or Crank it up as high as a Dual 1.8GHz for $595.00!
G4 Upgrades for PowerMac G3s, PowerMac G4s,
Cube G4, PowerBook G3s –
Even Legacy PowerMac 7200-9600 Models!

• More Speed for Less Cost
• Use all your existing memory,
peripherals, etc.
• Plug & Play and ZOOM
• Works with the Latest Software
& OS X Tiger too!
• Makes your current Mac like
new again!

30 Day
Money-Back

Up to 256MB of High-Performance
Video Memory
For 4X and 8X AGP G4, G5 models
Support for up to two Apple 30”
Cinema Displays!
Quartz Extreme, Tiger Core Video
Accelerated
For Power Mac G4 Digital Audio, QuickSilver,
Mirrored-Drive Door, and all G5 Models.

NEW! ATI Technologies
RADEON 9800 PRO MAC
EDITION $259.00
Ultra High Performance Dual
Head Video
Card W/ DVI, VGA and
S-Video Ports,
256MB. New, for
PowerMac G4s.
Quartz Extreme, Tiger Core
Video Accelerated

on NewerTech
and OWC brand
upgrades!

Give us a call or
check out our
website. Our
compatibility guide
will show just what
options are right to
make your Power
Mac, PowerBook,
iMac, etc - a Faster Mac today!
800.275.4576 macsales.com/Faster

Scope ou
our gaming t
macsales.com/gear!
gaming

Serving the Mac Universe since 1988
visit macsales.com 800.275.4576

Prices, specifications and availability are subject to change without notice. Items returned within 30 days may be subject to a restocking fee.
No return will be accepted without Return Merchandise Authorization number.

Right

Other World Computing
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Lifetime Warranty RAM

MEMORY, MACS
& MORE!
USED LAPTOP SPECIALS!!

ALL MEMORY ON SALE!!!

PowerBook DDR2
1GB Samsung
$119
512MB Samsung
55
PowerMac G5/iMac G5 DDR2/DDR
2gb 533MHz PC2-4200
$259
1gb Samsung
98
512mb Samsung
48
The memory market is extremely volatile. Prices are always
changing. Please call or check our web site for current pricing.

Genuine Apple Laptop Batteries
Batterie

All Models only $99

Available for:
PowerBook G4 Titanium
iBook 12” White/Snow
iBook Clamshell models
iBook 14” White/Snow

ew
Brand N ents
Replacem

Fresh Juice!

PowerBoo
from $599ks
!

Aluminum PowerBooks
12”
from $ 799
15”
from 1,099
17”
from 1,199
Titanium PowerBooks
15”
from $ 599
G3 iBooks
12”
from $ 399
G4 iBooks
12”
from $ 599
with 30-Day MacSolutions Warranty!

G5 Tower dual processor -from $1,399
QUANTITIES LIMITED

Call for details

MAC TRADE-INS WELCOME!
since
1994
®

800 •873 •3726

11933 Wilshire Boulevard, West LA, CA 90025
Phone: (310) 914-3200 Fax: (310) 966-4433
University & School P.O.’s Welcome. Prices subject to change without notice.

Ad code 210-6

MacSolutions.com

Adobe®
Creative Suite 2

Quark®
QuarkXpress 6.5

Macromedia®
Studio 8

Alias®

Order Today!

Only! $189.95

Only! $289.95

Only! $389.95

Save! $756

Save! 67%

The Industry-Standard!

Get the Best for Less!

Save! $710

Maya 7 Unlimited
Save! 85%

5 Programs - 1 Great Price!

Brand New Version!

We carry thousands of industry-leading software and hardware products at huge discounts for students, teachers and schools. These special prices are
ONLY for the academic community. And our prices are typically $10-$20 lower than most college bookstores! Call or visit us online today and start saving!

A d o be ®
Acrobat Pro 7............Save
Photoshop CS 2.........Save
Web Bundle ..............Save
Design Bundle...........Save

69%
52%
68%
66%

Alias®
Maya 7 Complete Student..$289
SketchBook Pro 2 Student ....$89

Macromedia® / A d o b e®
Dreamweaver 8..................$189
Flash Professional 8 ...........$239

Core l®
Painter IX..............................$89

Microsoft®
Office 2004 Student/Teacher ..$139

We carry many of the products reviewed in this magazine!
Epson Perfection 4490 Scanner .....$229
M-Audio Trigger Finger ..................$169
Palm Z22 Handheld..........................$99

Sorensen Squeeze 4.2 for Flash 8 ....$85
Lacie Silverscreen 40GB Drive........$189
Canon PowerShot A410 .................$139

Sibelius®
Sibelius 4.................................$239
Wa c o m®
Graphire4 6x8” Tablet..........$169
Intuos3 6x11” Tablet............$319

Hey Parents!
“You are eligible to buy for your
students at home or away at school.”

Give us a call anytime! 1-800-294-4035

Mac Shop APR/06
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FAMILY HISTORY - GENEALOGY

REUNION 8
®

We’ve got your back.

Reunion 8 is the perfect tool to
organize your family history. Plenty of
room for names, dates, places, stories,
notes, tidbits, and
sources. Include
all your favorite
pictures, sounds,
and home movies.
Automatically
build multimedia
web pages to
share your family
history on the
Internet! Print large, colorful tree
charts, timeline charts, and fan charts
for family reunions. Fun
and educational for the
whole family. Reunion 8
takes advantage of OS X
and includes over
100 new features
and enhancements!

Thousands of parts and accessories for your Powerbook

formerly PB FixIt. New name, same company
do-it-yourself Powerbook & iBook parts
free online step-by-step Fixit Guides
thousands of parts and upgrades

iFixit.com
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Leister Productions

web site/demo: www.LeisterPro.com
e-mail: info@LeisterPro.com

To order, call...

MacConnection 800-800-2222

MacAddict 3.5˝ X 2.3˝

DATA RECOVERY: 800-440-1904

7 great reasons to choose DriveSavers:
Fast, advanced, proprietary techniques.
All operating systems; Mac, Windows, OS/2,
Netware and UNIX.
� All storage devices including SAN, RAID
and NAS systems.
� Instantly retrieve recovered data
with DataExpress™.
� Recommended and certified by all
hard drive manufacturers.
� Government Contracts
“Restoring Data
� Featured on MacAddict,MacWorld,
and Peace of Mind
CNN, BBC and others.
Since 1985”
�
�

“We Can Save It!”

Visit DriveSavers at www.drivesavers.com

©2006 DRIVESAVERS, INC. 400 BEL MARIN KEYS BLVD., NOVATO, CA 94949 INTL: 415-382-2000

TM

Solutions that make sense.

RetractCable
iPod Dock Connector

• Retractable Docking Port Cable for iPod
• Choose High-Speed USB 2.0 or 6-pin Firewire

Auto Power
• In-Car Charger Adapter for iPod
• Choose USB or 6-pin Firewire Port

www.radtech.com

Mac Shop APR/06
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tell us how you really feel

If you have a dream about
a Mac coming alive through
a .Mac account and putting
OS X on all the PCs on the
planet, and then proceeding
to put viruses on Windows
Media Player, are you a Mac
addict?—Tim Harding
Indeed, that’s one of
the telltale signs of Mac
addiction, along with

Survey
Says

ACID TEST

The DNA tests have been ordered.

…THEN ANOTHER
Niko’s “Hack Your Toys”
article sucked. I hope he
puts more effort into future
articles. Or just fire him.
—Elbert Wall
Fear not, intrepid readers.
In response to your letters,
Niko was promoted to Editor
Supreme, then sacked, then
rehired as a janitor, and
finally assassinated … only
to be reincarnated as our
How-To Editor. Welcome
back, Niko!—Max

���
��

I must chastise you for
not including Acid Search
(free, http://pimpmysafari
.com/plugins/acid-search)
in your article about great
freeware and shareware
(“52 Must-Have Apps,”
Feb/06, p19). It’s a Safari
enhancement that lets you
preprogram search channels
and search independent
sites much faster and more
efﬁciently than just the
average Google search. If
the true test of a worthwhile
application is how much
you miss it when you use a
machine that doesn’t have
it, then the proof is in the
clicking.—CG

�

INFECTIOUS DREAMS

This question is about six years too late, but I have to ask:
Max looks very similar to baby Stewie on Fox’s Family Guy.
Max and MacAddict have been around since 1996. Has
anyone else seen the likeness between the two?
—Brian P. Keane
Well, I certainly have. But I’ve been advised that Rupert
Murdoch’s lawyers ﬁle their teeth to sharp points, so I’ve
never pressed the matter.—Max
IMAGE COURTESY OF FOX

In your review of the iH5
(Jan/06, p57), you said in
the Bad News, “Remote
control not included. Display
is a bit bright when trying to
sleep.” I purchased a white
one around November and a
black one a few days ago (a
newer version with inserts
for the nano and ﬁfth-gen
iPods), and both came with
a remote control. In addition,
the snooze bar actually says
“Snooze/Dimmer.” When
you press the button, the
display goes almost dark,
allowing for pleasant sleep
even if you’re facing toward
it.—Brian Bouldin
Oops, our bad. I do know
for certain that our writer fell
asleep at least a few times
during the course of this
review—we test our products
very thoroughly.—Max

MAX GRIFFIN

ONE OPINION…
After reading “Hack Your
Toys” (Feb/06, p58), which
explains how to turn your
GI Joe into a ﬂash-memory
head and your mouse into
a rubber rat, I’ve come
to this conclusion: Niko
Coucouvanis truly is the
biggest geek on the planet.
Congrats, Niko!—Ken Rackow

��
��

TROUBLED SLEEP

having written a widget
plug-in (and then having
converted it to a universal
binary) and constantly
sniffing macadamia nuts.
But seriously, Tim, even I’ve
have never had a dream that
geeky. Kudos, I think.—Max

��
���

LETTERS

SLR SLIP
Although you seem to have
gotten the specs of Nikon’s
D200 right (Get Info, Feb/06,

Will the real
D200 please
step forward?
(It’s the one
on the bottom.)

��
��
�

WHICH TV SHOW WOULD YOU BE MOST LIKELY
TO BUY FOR $1.99 ON THE iTUNES MUSIC STORE?

29% Walker,

Texas Ranger

9% Cop Rock

Here are the results
of our December
2005 survey. Check
out www.macaddict
.com each month for
a new online poll.

25%

9% The Howdy

H. R. Pufnstuf

��

��

Doody Show

11% Touched
by an Angel

17% The Many

Loves of Dobie Gillis

��
�

344 respondents
78

p13), you totally got the
photo wrong. The one you
showed was the “doctored
up” version that preceded
Nikon’s ofﬁcial release
image.—Jason Bateham
Indeed, we were taken in by a
scam—apparently the result
of some evil Photoshopper
toying with an image of the
Fuji S3, if the Internet is to be
believed. In any case, the real
photo’s below.—Max

April 2006

PRINT
DEMYSTIFICATION
Kudos to John Goodchild
for an awesome article
explaining the mysteries of
printing in plain and simple
English for the rest of us
(“What Kind of Printer Are
You?”, Jan/06, p30). I’ve
been selling printers for

WRITE TO US!

MacAddict, 4000 Shoreline Court, Ste. 400,
South San Francisco, CA 94080
or letters@macaddict.com

Epson for three years, and
I’ve told every confused
customer I’ve come across
to pick up a copy of your
magazine. There are only
two items I’d like to clarify:
First, all that a printer’s
DPI tells you is how many
places the print head can
stop and place ink on a
square inch of paper. Most
people think that DPI has
something to do with the
size of the droplet that the
head places, but that’s
actually controlled by the
size of the print head and
the method of applying ink
to paper. Second, the only
thing nozzle count affects
is print speed. The more
nozzles, the more ink can
be squirted at one time, the
faster the print.—Nick Hyde

FOR SUBSCRIPTION QUERIES:
call (toll-free) 888-771-6222

VANITY INSANITY
Instead of receiving my
usual monthly MacAddict in
December in the mail, I got the
January issue of Vanity Fair
with my MacAddict mailing
label attached. I really enjoy
looking at Naomi Watts a heck
of a lot better than looking at
Max or the MacAddict staff,
but I was really looking for the
inside content of MacAddict. If
you want to put Naomi on your
cover, that’s ﬁne—just make
sure that you’re sending me
the correct magazine.
—David Harrison

WIN!
Win a 500GB
SilverSATA II!
Do you need more storage space? How about a ton of
screamingly fast storage space? Well, write the best caption
to the picture below, and you’ll be the proud owner of a 500GB
WiebeTech SilverSATA II RAID array, plus a SATA2 PCI-X host
card so that you can connect it to your PCI-X–equipped Power
Mac G5 (total value over $900, www.wiebetech.com).

Entry Form
Write a caption
for this picture.

CONTESTANT INFORMATION

DARE NOT
SPEAK ITS NAME
I love my iBook G4 so much,
I want to marry it. Is there a
way I can track my beloved
down in case it’s ever stolen
away by some unscrupulous
PC user?—Chris Newitt
I believe it was either
Sting or some seagull who
once said, “If you love
something, set it free. If
it comes back, it’s yours.
If it doesn’t, it never was
yours.” Or you could check
out MacPhoneHome (www
.pcphonehome.com).—Max
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FOR CD PROBLEMS:
go to www.futureus-inc.com

Full Name:
Address:

What’s the matter, Dave, King
Kong ain’t Mac-y enough for ya?

City:

State:

Zip:
Email or telephone:

That was no mistake—the
whole “Mac” thing just
wasn’t working for us, so
we decided to try out a new
format. Unfortunately, we
didn’t realize there already
was a Vanity Fair. Whoops!
We’ll be testing Cat Fancy
and Bee Improvement and
Conservation variants
next. Hopefully those’ll go
better.—Max

S-E-X-X-Y
Your staff seems a bit testosterone-heavy these days.
Whatever happened to all the cool chicks like Jenifer
Morgan, Kris Fong, and Cathy Lu?—Richard Marvin
Congratulations, this is the millionth letter we’ve received
about how our current staff is made up entirely of guys—so
what better time to debut our sexy new mascot, Maxine!
swear.—Max
Ain’t she a darlin’? No, that’s not me in drag. I swear.—

Maxine’s so hot, she turns
the girl:boy ratio into its
reciprocal. Rrrawrrr!

Send email entries to: contest@macaddict.com with the subject: SilverSATA Contest
(Don’t forget to include your address information!)
Send snail-mail entries to: SilverSATA Contest; MacAddict magazine;
4000 Shoreline Court, Suite 400; South San Francisco, CA 94080.
Deadline for entry: April 30, 2006.
Contest results will appear in our Aug/06 issue.
Contest Rules The judges will be MacAddict editors and will base their decision on 33 percent humor, 33 percent
originality, and 33 percent creativity. All entries must be received no later than April 30, 2006, with the winner
announced around August 2006. By entering this contest, you agree that Future US, Inc. may use your name, likeness,
and Web site for promotional purposes without further payment. All prizes will be awarded, and no minimum number
of entries is required. If two or more people enter identical winning captions, the entry received ﬁrst will be awarded
the contest prize. Prizes won by minors will be awarded to their parents or legal guardians. Future US, Inc. is not
responsible for damages or expenses the winners might incur as a result of this contest or the receipt of a prize,
and winners are responsible for income taxes based on the value of the prize received. A list of winners may also be
obtained by sending a stamped, self-addressed envelope to Future US, Inc. c/o MacAddict Contest; 4000 Shoreline
Court, Suite 400; South San Francisco, CA 94080. This contest is limited to residents of the United States. No
purchase necessary, void in Arizona, Maryland, Vermont, Puerto Rico, and where prohibited by law.

Winner!
Congratulations to Joseph Harris,
whose caption earned him a
Canon EOS Digital Rebel XT SLR
camera ($999, www.canon
.com)—and a blanket Honorable
Geek Mention to the hundreds of
you who sent in ﬁrewall jokes.

“Dear Dorothy: Sad to
say, but Emerald City has
changed a lot since you
were here…”

Volume 11, Issue 4

MacAddict (ISSN 1088-548X) is published 12 times a year by Future US, Inc., 4000 Shoreline Court, Suite 400, South San
Francisco, CA 94080. Periodicals Postage Paid at South San Francisco, CA, and at additional mailing offices. Newsstand
distribution is handled by Curtis Circulation Co. Basic subscription rates: one year (12 issues + 12 CD-ROMs) U.S. $39.90,
Canada $43.95, U.S. prepaid funds only. Canadian price includes postage and GST 128220688. IPM 0962392. Outside the
U.S. and Canada, price is $53.95, U.S. prepaid funds only. POSTMASTER: Send address changes to MacAddict, P.O. Box
5126, Harlan, IA 51593-0626. Future US, Inc. also publishes Maximum PC, PC Gamer, Official Xbox Magazine, PSM, Guitar
World, Guitar One, Guitar World Acoustic, Bass Guitar, Guitar Legends, Future Music, Future Snowboarding, Snowboard Journal,
Snowboard Trade News, Skateboard Trade News, and Scrapbook Answers. Entire contents copyright 2006, Future US, Inc.. All
rights reserved. Reproduction in whole or in part is prohibited. Future US, Inc. is not affiliated with the companies or products
covered in MacAddict. Ride-Along enclosure in the following edition(s): A4, B, B1, B2. PRODUCED IN THE UNITED STATES OF
AMERICA. Publications Mail Agreement #40043631. Returns: 4960-2 Walker Road, Windsor ON N9A 6J3
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SHUT DOWN

don’t let the back page hit you on the way out

Trophy Podcasting
“There never were a bass more wily than Old Steve, who fought off every spinnerbait, spoon,
and crankbait ever cast his way. I myself tried everything from trimming my jig skirts to swimming
a rattle tube with shad-scented Sound Puddy! Then I heard about a new thing called podcasting,
so’s I packed up my Grifﬁn iTackle, replaced my Trilene XL with a white cable, clipped on a shiny
new iPod nano and a Belkin iSpinner, and ﬂip-cast. The rest, as they say, is history.”—Gill Baits
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ILLUSTRATION BY DOUG MARTIN

LACIE LOGO IS A TRADEMARK OF LACIE. © LACIE. ALL RIGHTS RESERVED 2006.

SHARE AND SHARE ALIKE.

DESIGNED FOR SMALL OFFICE AND HOME USERS, THE LACIE D2 ETHERNET DISK MINI OFFERS
THE DISTINCT STYLE OF THE ORIGINAL ALUMINUM D2, WITH THE BENEFIT OF ETHERNET
NETWORKING. PLUG IN THE USER-FRIENDLY ETHERNET DISK MINI TO INSTANTLY SHARE DATA,
PHOTOS, MUSIC AND MORE FROM ANY NETWORKED COMPUTER. WEB-BASED ADMINISTRATION
LETS YOU SET PERMISSIONS TO CONTROL USER ACCESS WITH EASE. WWW.LACIE.COM

